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About This GuideAbout This GuideAbout This GuideAbout This Guide
Welcome to Using Your Zodiac™ Console. This guide is designed to help you 
get up and running quickly on your console. It describes all you need to know 
about how to use your Zodiac console and the applications that come with it. 

This guide shows you how to:

• Identify all the parts of your console

• View and enter data 

• Use the applications that come with your console

• Use your console with your computer

• Personalize your console with your own preference settings

After you become familiar with the basic functionality of your Zodiac console, 
you can use this guide as a reference for less common tasks, for maintaining 
your Zodiac console, and as a source of information if you have problems 
operating it. For additional information visit tapwave.com.

Some of the applications that come with your Zodiac console are 
documented separately. If you do not find information about a particular 
application in this guide, look for the PDF file in the folder for that application 
on the CD that came with your Zodiac console or visit tapwave.com.

http://www.tapwave.com
http://www.tapwave.com
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1
Introduction to your Introduction to your Introduction to your Introduction to your 
Zodiac ConsoleZodiac ConsoleZodiac ConsoleZodiac Console
Your Zodiac console combines a full mobile entertainment experience -- 
including music, photos, movies, and interactive video games -- with the best 
organizer tools available.

Using HotSync® technology you can add media to your console as well as 
synchronize (exchange, update, and backup) your personal data.

Your Zodiac console gives you everything you need to go, do, and play.

System requirementsSystem requirementsSystem requirementsSystem requirements
To install and operate Palm Desktop software your computer system must 
meet the following minimum requirements:

• Windows 98 SE/2000 (with service pack 3)/me/XP Home/XP Pro (with 
administrator rights)

• IBM-compatible Pentium computer or higher

• 40 MB available hard disk space

• CD-ROM drive

• One available USB port

In addition, the following equipment is required for optional connectivity 
features: 

• Internet service provider (ISP) 

• Compatible mobile phone
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Connecting the cable or cradleConnecting the cable or cradleConnecting the cable or cradleConnecting the cable or cradle
The HotSync cable that comes with your Zodiac console enables you to 
synchronize the information on your console with your computer. You can 
also purchase an optional HotSync cradle to synchronize your console.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: If you are migrating from another Palm Powered™ console, follow 
the instructions on page 174 before connecting the cable or cradle and installing 
the Palm Desktop software.

1. Turn off your computer.

2. Plug the HotSync cable or cradle into a USB port on your computer.

3. Plug the power adapter into a power outlet.

4. Connect the power adapter cable and the HotSync cable.
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Charging the batteryCharging the batteryCharging the batteryCharging the battery
To use your Zodiac console, you must connect it to an AC outlet and charge 
the battery. 

1. Connect your console to an AC outlet using one of these three setups:

• Desktop Setup. Connect the optional HotSync cradle (sold separately) 
to the HotSync cable, your computer, and an outlet as described in the 
cradle instructions, and then insert your console in the cradle.

• Travel Setup. Connect the HotSync cable to your computer and an 
outlet as described on page 13, and then connect your console to the 
HotSync cable.

• Ultra-light Setup. Connect the power adapter cable to your console.

2. Wait approximately 2 hours for the battery to fully charge.

While your console charges, the LED is yellow. When your console is fully 
charged, the LED turns green.

When your console needs to be recharged, the LED blinks and turns yellow. 
When the LED turns red, your battery is extremely low.

Travel Setup Ultra-light Setup
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Charging tipsCharging tipsCharging tipsCharging tips
• Although you can turn your console on while it is charging, your 

console charges more quickly while it is turned off.

• The battery has a built-in sensor to prevent it from overheating. This 
also means that it stops charging if the environment is too warm.

– Keep in mind that operating your console while charging the 
battery generates heat.

– We do not recommend charging your console in environments 
that are over 86 degrees Fahrenheit.

– If you must charge your console in temperatures above 91 degrees 
Fahrenheit, do not turn it on while it is charging.

Battery lifeBattery lifeBattery lifeBattery life
Extend the life of your battery by following these guidelines:

• Use the lowest brightness setting you find comfortable (see page 23).

• Turn off your console as soon as you finish using it. Do not wait for the 
auto timeout to turn it off. 

• Keep the Auto-off after setting in General Preferences set to 30 
seconds in case you forget to turn off your console.

• Use the headphones when listening to music and videos and keep the 
volume low. Playing them loudly through the internal speakers will 
significantly reduce battery life. Playing them loudly through the 
headphones can permanently damage your hearing. 

• Turn off Bluetooth when you’re not using it.

• Turn off the Beam Receive setting in General Preferences when you’re 
not using the IR port to receive information from another device.
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Starting your console for the first timeStarting your console for the first timeStarting your console for the first timeStarting your console for the first time
The first time you start your Zodiac console, setup instructions appear on the 
screen. These instructions guide you through calibrating the touch-screen 
(also called the digitizer) and the analog controller. 

1. Press the Power button .

2. Follow the onscreen instructions, tapping the screen and moving the 
analog controller  where indicated. 

Palm Desktop softwarePalm Desktop softwarePalm Desktop softwarePalm Desktop software
Palm Desktop software includes many of the same applications as your 
Zodiac console: Photos, Music, Address Book, Date Book, To Do List, and 
Memo Pad. You can use the HotSync feature of this software to load, 
exchange, and backup files between your console and your computer.

It’s a good idea to back up your files in case something happens to the data on 
your Zodiac console. Changes you make on your Zodiac console or Palm 
Desktop software appear in both places after you synchronize.

Using the Palm Desktop software, you can do the following:

• Work with your Zodiac console applications on your computer to view, 
enter, and modify files stored on your console.

• Back up the files stored on your console with HotSync technology and 
synchronize the files in your Palm Desktop software. Synchronization is 
a one-step procedure that ensures your data is always safe and up-to-
date. See page 144 for more information. 

• Load compatible files and applications onto your console from your 
computer.

• Import and export data, so you can easily transfer data from other 
desktop applications into selected applications. See page 41 for more 
information.

• Print your Date Book, Address Book, To Do List, and Memo Pad 
information on any printer.
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Installing Palm Desktop softwareInstalling Palm Desktop softwareInstalling Palm Desktop softwareInstalling Palm Desktop software
The following instructions guide you through installing Palm Desktop 
software so that you can transfer data from your computer to your console.

Before you begin, make sure you connected the HotSync cable or cradle to 
your computer as described on page 13. 

After installation, refer to the online Help in Palm Desktop software for 
information on how to use the software.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: Do not copy the Palm Desktop software files to your 
computer’s hard disk. You must use the installer to place the files in 
their proper locations and to decompress the files. 

TIP:TIP:TIP:TIP: If you are a System Administrator preparing several consoles for a group 
of users, you may want to create a user profile to install a standard set of data. 
See page 176 before performing the first HotSync operation.

1. Exit any open programs, including those that run at startup (such as 
Microsoft Office), and disable any virus-scanning software.

2. Insert the Palm Desktop software CD into the computer’s CD-ROM drive. 

NOTE:NOTE:NOTE:NOTE: If the installation does not begin automatically, click the Windows 
Start button, choose Run, enter D:\autorun.exe, and then click OK. If necessary, 
replace D: with the drive letter assigned to your CD-ROM drive.

3. Follow the onscreen instructions to complete the installation. When 
prompted, complete the following steps:

a. Install Palm Desktop software, which also installs your free Bonus Software 
applications.

b. Select or create a user name.

c. Connect your console to the cable or cradle and synchronize.
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d. Create your FREE tapwave.com account.

Using your console with another desktop organizerUsing your console with another desktop organizerUsing your console with another desktop organizerUsing your console with another desktop organizer
If you prefer to use another desktop organizer, such as Microsoft Outlook, you 
can do so. After you install Palm Desktop software, simply install the 
connection software for your desktop organizer, called a conduit. The conduit 
lets you synchronize the data between your console and your desktop 
organizer. 

The Palm Desktop software CD includes PocketMirror from Chapura conduit, 
which enables you to synchronize the PIM applications (Date Book, Address 
Book, To Do List, and Memo Pad) with Microsoft Outlook. If you would like to 
synchronize these applications with Microsoft Outlook, first install Palm 
Desktop software, and then browse the CD for Chapura PocketMirror, and run 
the setup program to install it.

If you want to synchronize with a desktop organizer application other than 
Palm Desktop software or Microsoft Outlook or, you must purchase the 
necessary conduit software (if available).

http://www.tapwave.com
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Zodiac componentsZodiac componentsZodiac componentsZodiac components

AAAAbout the front panelbout the front panelbout the front panelbout the front panel

• Bluetooth button. Activates the built-in Bluetooth radio so that your 
Zodiac console can communicate with other devices that are enabled 
with Bluetooth technology. For details, see page 124 and page 170.

• Trigger buttons. Performs various actions based on the application. 

• Power button. Turns the console on (if it is off) and returns to the last 
screen that was displayed. Press the Power button again to turn the 
console off.

Pressing and holding the Power button opens the dialog box where 
you can adjust the sound volume and screen brightness. For details, 
see page 23.

The Power button also includes an LED that changes color based on 
the status of the battery. 

Console screen
Analog controller

Function button Home button

Action buttons

Power button

Bluetooth button

Left trigger

Right trigger

Left speaker

Right speaker

Headphone jack
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– Green. Appears when your console is connected to the cable or 
cradle and it is fully charged.

– Yellow. Appears when your console is charging.

– Red. Appears when your console battery is critically low and needs 
to be charged.

• Analog controller. Allows you to navigate through the Home screen 
and move around within applications. Move it in the direction you 
want to go, or press it when centered to select an item. For details, see 
page 25.

• Function button. Performs various actions based on the application. 
For example, in Date Book you can press this button to change the 
calendar display format.

• Left/Right speakers. Enables you to listen to music and game sounds 
without using the headphones. 

• Headphone jack. Enables you to connect headphones to your console 
so you can discreetly listen to music and game sounds.

• Home button. Opens the Home screen where you can select a game 
or application that you want to start. For details, see page 43.

• Console screen. Displays the applications and data stored in your 
console. It is touch-sensitive and responds to the stylus.

• Action buttons. Activates various functions based on the application. 
For example, in a game, these buttons might be used for acceleration, 
braking, stunts, or weapons, but in the Home screen, these buttons are 
shortcuts to your favorite games or applications. See page 47 for 
details on the Enable Quick Launch option to assign your favorite 
shortcuts to these buttons.
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About the back panelAbout the back panelAbout the back panelAbout the back panel

• Reset button. Under normal use, you should not have to use the reset 
button. See page 179 for information on when and how to use the 
reset button.

• IR port. Uses infrared technology to transmit data to and receive data 
from other devices, see page 167 for details. 

• Expansion slots. Enables you to expand your console’s storage 
capacity and capabilities by inserting expansion cards. See page 158 to 
learn more about using expansion cards.

• HotSync connector. Connects your console to the cable or cradle, 
which in turn connects to your computer and the AC adapter. This 
allows you to recharge your console and to synchronize the 
information between your console and your computer using HotSync 
technology. For more information, see page page 144.

• Stylus channel and stylus. Holds the stylus when you are not using it. 
The stylus is the writing instrument you use to enter data on your 
console.

IR port

Reset button
HotSync connector

Stylus channel 
and stylus

Expansion slots
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Removing the stylusRemoving the stylusRemoving the stylusRemoving the stylus
To use the stylus, remove it from the channel and hold it as you would a pen 
or pencil.

Connecting the headphonesConnecting the headphonesConnecting the headphonesConnecting the headphones
Your Zodiac console includes a pair of stereo headphones that you can use 
while listening to music, playing games, or watching video clips. Using 
headphones or external speakers instead of the built-in speakers also 
conserves battery power.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: When using the headphones, keep the volume soft. Listening to 
loud volumes through the headphones can permanently damage your hearing.
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Adjusting the screen orientationAdjusting the screen orientationAdjusting the screen orientationAdjusting the screen orientation
In many applications you can change the orientation of your Zodiac display 
by switching between portrait (vertical) and landscape (horizontal) mode. 

• Tap the Orientation icon  in the Status Bar to switch between 
portrait and landscape mode. See page 26 to learn about the Status 
Bar.

TIP:TIP:TIP:TIP: In landscape mode, you can also choose whether the Status Bar 
and Input Area appear on the left or right side of the screen. For details, 
see page 130.

Adjusting the speaker volume and screen brightnessAdjusting the speaker volume and screen brightnessAdjusting the speaker volume and screen brightnessAdjusting the speaker volume and screen brightness
You can quickly adjust the volume level or sound in your applications and the 
brightness of your screen to make it easy to see in a variety of lighting 
conditions.

1. Press and hold the Power button  or tap the Power Controls icon  in 
the Status Bar. 

2. Adjust the sound by doing one of the following:

• Tap the Sound icon and drag the slider to adjust the volume level.

• Tap the Mute icon and choose how long the sound remains off.

3. Adjust the brightness by doing one of the following: 

• Drag the slider to adjust the brightness.

• Tap to the right or left of the slider to adjust the brightness in small 
increments.

4. Tap Done.

Sound icon Mute icon

Brightness 
slider

Sound 
slider
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Opening applicationsOpening applicationsOpening applicationsOpening applications
You can use the Home screen to open any application installed on your 
console. The Home screen displays your user name, the current time, the 
battery level, a radial menu of your favorite categories, and a list of remaining 
categories. 

You can choose which icons appear on the radial menu and which icons 
appear on the list. If you have expansion cards inserted in the expansion slots, 
each card appears as a category.

1. Press the Home button . 

2. Open a category by doing one of the following:

• Move the analog controller  in the direction that corresponds to the 
category you want to open. The placement of the icon on the radial 
menu corresponds to the directional controls on the analog controller. 
After you highlight your selection, release the analog controller to 
open the category.

• Press the Function button to move from the radial menu to the list, and 
then scroll to a category on the list. With the analog controller  
centered, press it to open the category. 

• Tap a category icon on the screen. 

TIP:TIP:TIP:TIP: To view a list of all your applications, select All from the category list on 
the right side of the screen.

Radial menu

Menu list
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3. Open an application by doing one of the following:

• Move the analog controller  in the direction that corresponds to the 
application you want to open. The placement of the icon on the radial 
menu corresponds to the directional controls on the analog controller. 
After you highlight your selection, release the analog controller to 
open the application.

• Scroll to an application icon in the All view list (if you already selected 
the All category). With the analog controller  centered, press it to 
open the application. 

• Press the Function button to move from the radial menu to the list, and 
then scroll to an application on the list. With the analog controller  
centered, press it to open the application. 

• Tap an application icon on the screen. 

Learning to navigateLearning to navigateLearning to navigateLearning to navigate
Just as you use a mouse pointer to click elements on your computer’s screen, 
you use the stylus to tap elements on your console’s touch-sensitive screen. 
Tapping is the basic action used to perform tasks on your console. In addition, 
you can drag the stylus to select text.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: Always use the point of the stylus for tapping or making strokes 
on the console screen. Do not use a pen, pencil, or any other sharp object to 
write or tap on the console screen, as it may damage the screen. If you 
misplace your stylus, visit tapwave.com for information on a replacement.

http://www.tapwave.com
http://www.tapwave.com
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Status Status Status Status BarBarBarBar
The Status Bar can appear on the far right, on the far left, or at the bottom of your 
screen. When you tap an icon on the Status Bar, it performs the following actions:

• Home icon . Displays the Home screen where you can open applications.

• Menu icon . Displays the menu bar where you can choose menu commands.

• Find icon . Opens the Find dialog box where you can perform system-wide 
searches on a text string.

• Power Controls icon . Displays the volume, mute, and brightness controls.

• Music Controls icon . Opens the Music Controls dialog box where you can 
control music settings with the analog controller, switch to the power-saving 
Hold state, or open the Music application. A pause symbol appears in the 
upper-left corner of this icon when playback is paused. For more information, 
see page 57.

• Attention icon . Flashes when you have alerts to review.

• Orientation icon . Switches the orientation of the screen display between 
portrait and landscape mode (when available). In landscape mode, you can also 
choose whether the Status Bar and Input Area appear on the left or right side of 
the screen. This option is designed to facilitate left-handed data entry in 
applications that support this feature. For more information, see page 130.

• Expand/Collapse icon . Expands and collapses the Input Area display to 
provide a larger viewing area while playing games or using applications where 
data entry is not required. If the application is designed to take advantage of 
the extra screen space, you can view additional information where the Input 
Area normally appears. 

Status Bar
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Input AreaInput AreaInput AreaInput Area
The Input Area enables you to enter data on your console using Graffiti® 2 
characters or the onscreen keyboard. It includes the following elements:

• Division marks. Separates the various portions of the Input Area. 

• ABC and abc. Indicates which type of Graffiti 2 characters (upper or 
lower case) you can write in this portion of the Input Area. When you 
tap these icons, the alphabetic onscreen keyboard appears.

• 123. Indicates that you can write numeric Graffiti 2 characters in this 
portion of the Input Area. When you tap this icon, the numeric 
onscreen keyboard appears.

NOTE:NOTE:NOTE:NOTE: The cursor must be in an input field to enter Graffiti 2 characters 
or open the onscreen keyboard. 

Division 
marks

Division 
marks

ABC

ABC

abc 123

abc

123
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Entering dataEntering dataEntering dataEntering data
You can enter text, numbers, and symbols into your Zodiac in four ways:

• Using Graffiti 2 (see page 32)

• Using the onscreen keyboard (see page 39)

• Using an external keyboard (see page 41)

• Entering or importing data in Palm Desktop software, and then 
synchronizing with your console (see page 40)

There are also onscreen controls that enable you to enter data by selecting 
options:

• Pick list. Displays a list of choices. Tap the black triangle next to the 
pick list name to display a list of choices, and then tap an item in the list 
to select it. 

• Box. Indicates the state of the corresponding option. A check mark in a 
box means the option is active. If a box is empty, tapping it inserts a 
check mark. If a box is checked, tapping it removes the check mark.

• Button. Initiates a command when tapped. Buttons, such as New or 
Done, appear in dialog boxes and at the bottom of application screens.

Pick list

Box

Button



Introduction to your Zodiac Console
Learning to navigate

Using Your Zodiac Console 29292929

Navigation controlsNavigation controlsNavigation controlsNavigation controls
Many applications include onscreen controls that enable you to navigate 
through your data:

• Next or previous arrow. Displays the previous or next page of 
information.

• Scroll bar. Moves through long notes or memos. Tap and hold down 
the scroll bar slider to scroll through pages; tap the slider arrow at 
either end to move one line at a time. To scroll to the previous page, 
tap the scroll bar just above the slider; to scroll to the next page, tap 
the scroll bar just below the slider. You can also scroll to the previous 
and next pages by moving the analog controller  Up and Down.

Menus Menus Menus Menus 
Menus and commands are specific to each application and area within the 
application. For example, in Memo Pad, the Memo List screen and the Memo 
screen display different menus. 

Some applications or screens do not have menus. Where available, menu 
commands for each application are described in the corresponding 
application’s chapter, with the exception of the Edit menu. For information on 
Edit menu commands, see page 72.

Next 
arrow

Previous 
arrow

Scroll bar 
slider

Scroll bar 
arrow
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1. Tap the Menu icon  or the title bar to open the menu bar.

2. Select a command from the menu by tapping it with the stylus or by 
moving the analog controller  to highlight it and then pressing the 
analog controller while it is centered. 

Command toolbarCommand toolbarCommand toolbarCommand toolbar
The command toolbar enables you to initiate a command by tapping an icon 
or writing a Graffiti 2 quick stroke instead of using the menus. Most menu 
commands have an equivalent Graffiti 2 quick stroke, which is similar to 
keyboard shortcuts used to execute commands on computers. 

The Graffiti 2 quick stroke appears next to the command in the menu. To use 
Graffiti 2 quick strokes, menus must be closed.

1. In the abc or ABC portions of the Input Area, draw the Graffiti 2 menu 
command stroke (a diagonal line from the lower-left to upper-right) to 
display the command toolbar.

2. Within 4 seconds, do one of the following:

• Tap an icon that represents the command you want. The icons vary 
within each application. 

• Enter a Graffiti 2 quick stroke in the Input Area. For example, to choose 
Select All from the Edit menu, draw the letter S. 

TIP:TIP:TIP:TIP: If you wait more than four seconds to draw the quick stroke letter, you 
need to redraw the menu command stroke to redisplay the command toolbar.
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TipsTipsTipsTips
Many of the dialog boxes that appear on your console contain a Tips icon in 
the upper-right corner. Tips anticipate questions you may have and provide 
shortcuts for using the dialog box or other useful information. 

1. Tap the Tips icon  in the upper-right corner of the dialog box. 

2. Tap Done after reading the tip. 

Tips icon
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2
Entering Data in Entering Data in Entering Data in Entering Data in Your Your Your Your 
Zodiac ConsoleZodiac ConsoleZodiac ConsoleZodiac Console
You can enter data into your Zodiac console by using the onscreen keyboard, 
writing with the stylus in the Input Area, using your computer keyboard, 
using an external keyboard, or by importing data from another application.

EEEEntering data using ntering data using ntering data using ntering data using GGGGraffiti 2 handwriting softwareraffiti 2 handwriting softwareraffiti 2 handwriting softwareraffiti 2 handwriting software
You can use Graffiti 2 strokes to create letters, numbers, punctuation, and 
symbols. The Graffiti 2 writing strokes include all letters, numbers, and 
symbols found on a standard keyboard. 

Learning to write Learning to write Learning to write Learning to write GGGGraffiti 2 charactersraffiti 2 charactersraffiti 2 charactersraffiti 2 characters
With only a few minutes of practice, you’ll find it easy to enter accurate text 
and numbers using Graffiti 2 writing strokes.

The Graffiti 2 demo shows how to use the handwriting software. The first 
time you turn on your console the Welcome application automatically guides 
you through the setup process. When you complete setup, you are invited to 
learn how to use the Graffiti 2 handwriting software.

After you view the Welcome application the first time, a Graffiti 2 Demo icon 
 appears in the Utilities category on the Home screen. Select this icon to 

view the demo at any time. You can also select the Welcome icon  in the 
Utilities category to view the Welcome application again. 

TIP:TIP:TIP:TIP: When you reach the Stroke Lookup screen of the demo, use the pick 
list to view the wide variety of characters that you can make. As you tap a 
character, an animation of the strokes used to form that character appears. 
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General Guidelines for Graffiti 2 WritingGeneral Guidelines for Graffiti 2 WritingGeneral Guidelines for Graffiti 2 WritingGeneral Guidelines for Graffiti 2 Writing
Follow these guidelines to learn and use Graffiti 2 writing strokes successfully: 

• To achieve 100% accuracy, practice drawing characters exactly as they 
appear in the tables later in this chapter.

• The heavy dot on each shape indicates where to start the stroke. Some 
characters have similar shapes, but different starting and ending 
points. Always start the stroke at the heavy dot, but do not draw the 
heavy dot; (it is there only as a guideline). 

• The Graffiti 2 writing strokes for letters closely resemble letters of the 
standard English alphabet, both uppercase and lowercase. Graffiti 2 
includes symbols made with a single stroke and symbols made with 
multiple strokes.

For multi-stroke characters, a temporary character appears after the 
first stroke, to show that the stroke was recognized. For example, after 
the first vertical stroke of “t”, a temporary “l” is shown. There is a limited 
time window, during which you must draw the second stroke. 
Otherwise the temporary stroke is recorded.

• The Input Area is divided into three parts, one for writing uppercase 
letters, one for writing lowercase letters, and one for writing numbers. 
The small marks at the top and bottom of the Input Area define the 
division lines. To have your console recognize uppercase letters, 
lowercase letters, and numbers, you must begin the strokes in the 
corresponding portion of the Input Area.

Tap here to view 
other strokes
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1. Tap the screen where you want to write text, for example, on a line next to 
a time in Date Book. 

NOTE:NOTE:NOTE:NOTE: A blinking cursor must appear onscreen in the entry field before you 
can begin writing text. 

2. Use the tables on the following pages to find the stroke shape for the 
letter you want to write. For example, the stroke shown below creates the 
letter A. 

You use the same shape to create both the lowercase letter and the 
uppercase letter.

3. Position the stylus in the appropriate place of the Input Area depending 
on whether you want to write an uppercase or lowercase letter. 

4. Start your stroke at the heavy dot, and draw the stroke shape as it 
appears in the tables.

5. Lift the stylus from the screen at the end of the stroke shape.

6. Your console recognizes your stroke immediately and displays the letter 
at the insertion point onscreen. As soon as you lift the stylus from the 
screen, you can begin the stroke for the next character you want to write.

Write uppercase 
letters here

Write numbers 
here

Write lowercase letters here

Division marks

Start stroke at 
heavy dot

Lift stylus here
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Graffiti 2 Graffiti 2 Graffiti 2 Graffiti 2 ttttipsipsipsips
When using Graffiti 2 writing, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes that nearly 
fill the Input Area are easily interpreted. 

• To delete characters, set the insertion point to the right of the 
character you want to delete, and draw the Backspace stroke (a line 
from right to left) in the Input Area.

• Write at natural speed. Writing too slowly can produce errors.

• Do not write at a slant. Keep vertical strokes parallel to the sides of the 
Input Area.

• When letters and numbers can be written using two different strokes, 
use the one that’s easiest for you. 

• Press firmly.

• Some characters can be formed in more than one way, and you can 
choose which method you prefer. See page 131 for details.

The The The The GGGGraffiti 2 alphabetraffiti 2 alphabetraffiti 2 alphabetraffiti 2 alphabet
Draw Graffiti 2 letters according to the following alphabet.
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Writing Writing Writing Writing ppppunctuation marks and other special charactersunctuation marks and other special charactersunctuation marks and other special charactersunctuation marks and other special characters
Using Graffiti 2 writing, you can create any punctuation symbol and special 
character available from a standard keyboard. 

• Punctuation marks. The period and comma punctuation marks can 
be written in any portion of the Input Area (the uppercase, lowercase, 
or number area). Other common punctuation marks can be written 
only in specific parts of the Input Area. The chart below indicates 
where the punctuation marks must be drawn (in general, the more 
frequently used punctuation is on the left side). 

– Characters that appear on the left side of the chart must be drawn 
in the alphabetic (uppercase or lowercase) portions of the Input 
Area. 

– Characters that appear on the right side of the chart must be drawn 
in the number portion of the Input Area.

TIP:TIP:TIP:TIP: If you draw the Shift stroke (see page 36) before entering a punctuation 
mark, you can enter punctuation strokes anywhere in the Input Area. This 
requires an extra stroke, but you may find it easier, since you don’t have to 
remember on which side of the Input Area to make the punctuation strokes.

• Symbols and other special characters. You can write symbols and 
other special characters using the Shift command. When you make a 
vertical stroke from the bottom to the top in the Input Area, the Shift 
indicator arrow appears in the lower right corner of the screen. While 
this arrow is visible, you can make the characters shown in the 
illustration below. Once the arrow goes away, the symbol or other 
special character appears.
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TIP:TIP:TIP:TIP: Using an additional Shift stroke to finish writing the character (as shown 
in the demo) is optional, but it makes the character appear more quickly.

After drawing the Shift stroke, draw punctuation marks, symbols or accent 
marks using the following strokes:

TIP:TIP:TIP:TIP: Samples of the character strokes are available in the Graffiti 2 Help file. 
To view the Help file, tap the Menu icon , and from the Edit menu, select 
Graffiti 2 Help. Note that the accented characters appear on a Punctuation 
Shift screen, but do not use the Shift command.

• Accented letters. When writing letters with accent marks, first write 
the uppercase or lowercase letter stroke in the appropriate portion of 
the Input Area. Then quickly write the accent stroke (shown above) in 
the number portion of the Input Area.
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UUUUsing Graffiti 2 Gesturessing Graffiti 2 Gesturessing Graffiti 2 Gesturessing Graffiti 2 Gestures
Gestures are editing commands, such as cut, paste, and the ShortCut 
command which is explained in the next section. To use gestures, draw the 
following strokes:

TIP:TIP:TIP:TIP: The Menu command stroke must be drawn in either of the letter 
portions of the Input Area. The remaining strokes can be drawn anywhere 
in the Input Area.

Using Graffiti 2 ShortCutsUsing Graffiti 2 ShortCutsUsing Graffiti 2 ShortCutsUsing Graffiti 2 ShortCuts
Graffiti 2 ShortCuts let you quickly and easily enter commonly used words or 
phrases. ShortCuts are similar to the Glossary or Autotext features of some 
word processors. Graffiti 2 writing comes with several predefined ShortCuts. 
You can also create your own for any words, letters, or numbers, see page 141 
for details.

Your console includes the following predefined Graffiti 2 ShortCuts for 
common entries:

• br—Breakfast

• di—Dinner

• ds—Date stamp

• dts—Date/time stamp

• lu—Lunch



Entering Data in Your Zodiac Console
Using the onscreen keyboard

Using Your Zodiac Console 39393939

• me—Meeting

• ts—Time stamp

1. Draw the ShortCut stroke.

2. Draw the ShortCut character(s). 

When you draw the ShortCut stroke, the ShortCut symbol appears at the 
insertion point.

Using the onscreen keyboardUsing the onscreen keyboardUsing the onscreen keyboardUsing the onscreen keyboard
You can open the onscreen keyboard anytime you need to enter text or 
numbers on your console. 

1. Open any application (such as Address Book). 

2. Tap any record, or tap New.

3. In the Input Area, tap one of the following to display the corresponding 
onscreen keyboard:

• ABCABCABCABC or abc abc abc abc - display the alphabetic keyboard. 

• 123123123123 - displays the numeric keyboard. 

ShortCut

   

Division 
marks

Division 
marks

ABC

ABC

abc 123

abc

123
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4. To display the international keyboard, open an onscreen keyboard, and 
then tap Int’l at the bottom of the keyboard display. 

TIP:TIP:TIP:TIP: To select any of the three keyboards, tap the Menu icon  and then 
tap Edit. Tap Keyboard, and then tap the keyboard you want.

.

5. Tap the desired characters or numbers; then tap Done to enter the text or 
numbers. 

Using your computer Using your computer Using your computer Using your computer kkkkeyboard eyboard eyboard eyboard 
At times, you may prefer to use your computer keyboard rather than the 
onscreen keyboard to enter or modify information on your console.

You can enter information from your computer keyboard using Palm™ 
Desktop software or any supported desktop organizer installed for use with 
your console. You can then perform a HotSync operation to synchronize the 
information on your computer with the information you entered on your 
console. All the Organizer applications on your console are available in Palm 
Desktop software and in most desktop organizer software.

Refer to Palm Desktop online Help for more information on entering data on 
your computer.

Backspace

Carriage return

Tab

Caps Lock

Caps Shift

Tap here to display 
alphabetic keyboard 

Tap here to display 
numeric keyboard

Tap here to display 
international keyboard

AlphaAlphaAlphaAlpha

NumericNumericNumericNumeric InternationalInternationalInternationalInternational
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Using an external keyboardUsing an external keyboardUsing an external keyboardUsing an external keyboard
You can connect an optional external keyboard accessory to your console so 
you can type data directly into your console. External keyboards are very 
useful for typing large amounts of data quickly and accurately while you are 
away from your computer. Visit tapwave.com to learn about keyboards and 
other accessories available for your console.

Importing Importing Importing Importing ddddataataataata
If you have data stored in computer applications such as spreadsheets and 
databases, or if you want to import data from another device, you can transfer 
the data to your Zodiac console without entering it manually. Save the data in 
one of the file formats listed below, import it into Palm Desktop software, and 
then perform a HotSync operation to transfer the data to your console.

Palm Desktop software can import data in the following file formats: 

• Comma delimited (.csv, .txt): Address Book and Memo Pad only.

• Tab delimited (.tab, .tsv, .txt): Address Book and Memo Pad only.

• CSV (Lotus Organizer 2.x/97 Mapping): Address Book only.

• vCal (.vcs): Date Book only.

• vCard (.vcf): Address Book only.

• Date Book archive (.dba).

• Address Book archive (.aba).

• To Do List archive (.tda).

• Memo Pad archive (.mpa).

Archive formats can only be used with Palm Desktop software. Use the archive 
file formats to share information with other people who use Palm Powered 
devices or to create a copy of your important Palm Desktop information.

1. Open Palm Desktop software.

2. Click the application into which you want to import data.

3. If you are importing records that contain a field with category names, do 
the following:

http://www.tapwave.com 
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a. Select Edit Categories from the Category list.

b. Make sure that all the categories that appear in the imported file also exist in 
the application. 

c. If any of the categories do not exist, click New and create the categories now; 
otherwise, the records you import will be placed in the Unfiled category. 

d. Click OK.

e. Select All from the Category list.

4. Choose File > Import; then select the file you want to import, and click 
Open. 

5. To import data into the correct Palm Desktop fields, drag fields in the left 
column so that they are opposite the corresponding imported field on the 
right.

6. To exclude a field from being imported, uncheck the field’s box. 

7. Click OK.

8. The imported data is highlighted in the application.

9. To add the imported data to your console, perform a HotSync operation.

See Palm Desktop online Help for more information on importing and 
exporting data.
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3
Managing ApplicationsManaging ApplicationsManaging ApplicationsManaging Applications
This chapter explains how to switch between applications on your Zodiac 
console, how to personalize application settings, and how to organize 
applications into related groups. 

Using the Using the Using the Using the HHHHome screenome screenome screenome screen
The Home screen enables you to open applications on your console. All the 
applications installed on your console are organized into categories which 
appear in the Home screen. By default the Home screen displays a radial 
menu and list of your application categories. When you choose a category, 
the applications in that category appear on the radial menu and in the list.

In addition to providing a way for you to open applications, the Home screen 
also displays your user name, the battery level, and the current time. When 
you open a category, the category name replaces your user name.

You can customize the Home screen as described later in this chapter.

1. Press the Home button  or tap the Home icon. 
.

Radial menu

Menu list
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2. Open a category by doing one of the following:

• Move the analog controller  in the direction that corresponds to the 
category you want to open. The placement of the icons on the radial 
menu correspond to the directional controls on the analog controller. 
After you highlight your selection, release the analog controller to 
open the category.

• Press the Function button to move from the radial menu to the list, 
then scroll to a category on the list. With the analog controller  
centered, press it to open the category. 

• Tap a category icon on the screen. 

TIP:TIP:TIP:TIP: To view a list of all your applications, select All from the category list on 
the right side of the screen.

3. Open an application by doing one of the following:

• Move the analog controller  in the direction that corresponds to the 
application you want to open. The placement of the icons on the radial 
menu correspond to the directional controls on the analog controller. 
After you highlight your selection, release the analog controller to 
open the application.

• Scroll to an application icon in the All view list (if you already selected 
the All category). With the analog controller  centered, press it to 
open the application. 
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• Press the Function button to move from the radial menu to the list, and 
then scroll to an application on the list. With the analog controller  
centered, press it to open the application. 

• Tap an application icon on the screen. 

CCCCustomizing the ustomizing the ustomizing the ustomizing the HHHHome screen displayome screen displayome screen displayome screen display
There are several ways you can customize the Home screen display. You can 
rearrange the icons on radial menus, move applications to a different 
category, create new categories, and set display and button preferences.

Arranging Arranging Arranging Arranging icons on icons on icons on icons on the radial menusthe radial menusthe radial menusthe radial menus
Each radial menu can contain up to eight icons. You can move icons to a 
different spoke on a radial menu, or move them between a radial menu and 
the corresponding list.

To arrange the radial menus, do any of the following: 

• Drag an icon from the list to a spoke on the radial menu. If that spoke is 
already occupied, the previous occupant moves to the list.

• Drag an icon from one spoke on the radial menu to another spoke. If 
the new spoke is already occupied, the icons trade places.

• Drag an icon from the radial menu to the list. The spoke remains empty 
and the icon appears in alphabetical order on the list.

Organizing Organizing Organizing Organizing aaaapplicationspplicationspplicationspplications
Your Zodiac console supports up to 15 categories. The category feature 
enables you to organize your applications into logical groups so that you can 
easily find and open them. You can move applications between categories 
and add, rename, and delete categories as needed.

Moving applications between categories

1. Press the Home button . 

2. Tap the Menu icon . 

3. From the App menu, select Category. 
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4. From the pick list next to an application, select a different category.

5. Tap Done.

Creating or renaming a category 

1. Press the Home button . 

2. Tap the Menu icon . 

3. From the App menu, select Category. 

4. Tap Edit Categories.

5. Tap New or Rename. 

6. Enter the category name, and then tap OK to add or rename the category. 

7. Tap OK to close the Edit Categories dialog box.

8. Tap Done.
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Deleting a category

1. Press the Home button . 

2. Tap the Menu icon . 

3. From the App menu, select Category. 

4. Tap Edit Categories.

5. Select a category, and then tap Delete. 

6. Tap Yes to confirm deletion.

7. Tap Done.

Setting Home screen preferencesSetting Home screen preferencesSetting Home screen preferencesSetting Home screen preferences
You can use the Home screen Preferences settings to change the background 
graphic, display all your applications in an alphabetical list, and map 
applications to the action buttons. 

1. Press the Home button . 

2. Tap the Menu icon . 

3. From the Options menu, select Preferences. 

4. Set any of the following options:

• Background. Replace the background with any JPEG picture available 
in the Photos application on your console.

• Color Theme. Set the background color for the Home screen. To 
change the colors, tap the color box to open the Home Color Themes 
dialog box, tap a color theme, and then tap OK.
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TIP:TIP:TIP:TIP: To create a custom color background, tap the pick list in the lower-
right corner of the Home Color Themes dialog box and use the Palette, RGB, 
or HSV settings to create your own background.

• Open to. Choose which screen appears when you press the Home 
button. 

– Home Screen. Display the top level radial menu that shows the 
various categories.

– All Applications. Display all of your application icons in an 
alphabetical list (instead of radial menus).

– Last View. Display the last Home screen or category you viewed.

• One button Quick Launch from Home Screen. Open the assigned 
applications when you press each of the four Action buttons from the 
Home screen. Use the Quick Launch Preferences screen to assign 
applications to the Action buttons. See page 141 for details.

5. Tap Done. 

Viewing information on an Viewing information on an Viewing information on an Viewing information on an aaaapplicationpplicationpplicationpplication
You can get information on any application by displaying the Info screen. The 
Info screen displays the name, version number, size, and number of records 
associated with each application on your console. 

1. Press the Home button . 

2. Tap the Menu icon . 

3. From the App menu, select Info. 

Tap pick list to create 
a custom color back-
ground
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4. From the Device pick list, select Console or the name of an expansion card 
inserted in a slot.

5. Tap Version, Size, Records to view the corresponding information for the 
selected device.

6. Tap Done. 

Installing add-on Installing add-on Installing add-on Installing add-on aaaapplicationspplicationspplicationspplications
In addition to the applications that came with your console, you can use the 
Install Tool to install applications (called add-on applications) during a 
HotSync operation. A variety of third-party games and applications are 
available for your console; for more information visit tapwave.com. 

Add-on applications can reside in your console’s internal memory or on an 
expansion card. You can remove add-on applications at any time; for more 
information, see page 51.

There are also several Bonus Software applications included on the CD that 
came with your console. If you did not install these applications when you 
installed Palm Desktop software, you can install them at any time by choosing 
the Install Bonus Software option from the CD menu. After you install an 
application, check the CD for the accompanying documentation.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: Some games require special installation tools. Check the README 
file for your game to see if you can use the Palm Install Tool or if you need a 
special installation tool. 

Some add-on applications consist of multiple PRC or PDB files. Check the 
application’s manual to ensure that you install all the required files.

http://www.tapwave.com
http://www.tapwave.com
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1. From your computer, double-click the PRC or PDB file you want to install.

The Install Tool window opens and the selected file appears in the list of 
applications to install.

TIP:TIP:TIP:TIP: You can also select the Install Tool dialog box by selecting Install Tool 
from the Palm Desktop program group, or by clicking the Install icon in Palm 
Desktop software.

2. In the User drop-down list, select the user name that corresponds to your 
Zodiac console. 

3. (Optional) Click Change Destination, click the arrows to indicate whether 
you want to install the application on your console or an expansion card, 
and then click OK.

TIP:TIP:TIP:TIP: If you decide not to install an application, select it in the list of files in the 
Palm Install Tool dialog box and click Remove. The application is removed from 
the dialog box list, but not from your computer. 

4. Click Done. A message appears to indicate that the application(s) will be 
installed the next time you perform a HotSync operation. 

5. Perform a HotSync operation to install the application(s). For details, see 
page 144.
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Removing Removing Removing Removing aaaadd-on applicationsdd-on applicationsdd-on applicationsdd-on applications
If you run out of memory or no longer need them, you can remove add-on 
applications, patches, and extensions from your console.

You cannot remove the built-in applications that reside in ROM on your 
console.

1. Press the Home button . 

2. Tap the Menu icon . 

3. From the App menu, select Delete.
 

4. From the Delete From pick list, select Console.

5. Tap the application you want to remove. 

6. Tap Delete.

7. Tap Yes.

8. Tap Done.

The application is deleted. Applications that are loaded in ROM (for example, 
Memo Pad) cannot be deleted, and are not listed.
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RemovingRemovingRemovingRemoving Palm Desktop software Palm Desktop software Palm Desktop software Palm Desktop software
If you no longer want to synchronize data with your computer, you can 
remove Palm Desktop software from your computer. 

NOTE:NOTE:NOTE:NOTE: Do not remove Palm Desktop software if you plan to synchronize 
data with another desktop organizer application such as Microsoft Outlook. 
Palm Desktop software also includes the HotSync Manager software used 
to synchronize with your selected desktop application.

1. From the Windows Start menu, choose Settings > Control Panel.

2. Double-click the Add/Remove Programs icon. 

3. On the Install/Uninstall tab, select Palm Desktop software; then click Add/
Remove.
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4
Using MusicUsing MusicUsing MusicUsing Music
Music provides a full-featured mobile MP3 player right on your console. 

Use Music to: 

• Listen to songs and other MP3 files stored on your console or an 
expansion card.

• Upload songs from your computer to your console or an expansion 
card.

• Update a list of songs you created with the Music component in Palm 
Desktop software.

Opening Opening Opening Opening MusicMusicMusicMusic
1. Press the Home button . 

2. Select the Media category .

3. Select the Music icon .

• Previous Track . Restart the current track, or if the current track has 
been playing for less than 2 seconds, select the previous track on the 
song list.
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• Next Track . Select the next track on the song list.

• Volume Down . Lower the speaker or headphone volume level. 
The volume indicator appears when you tap this button.

• Volume Up . Raise the speaker or headphone volume level. The 
volume indicator appears when you tap this button.

• Play/Pause . Start and stop playback of the selected song. When a 
song is playing, the Pause button appears. When a song is not playing, 
the Play button appears.

• Repeat . Select Repeat replays the entire song list after the last 
song plays. If Repeat is not selected, your console shuts off after the 
last song.

• Shuffle . Select Shuffle to create a randomly ordered song list. 
Deselect Shuffle to return the songs to their prior order.

• Console . Select console to display songs stored in the internal 
memory on your console. If there are no songs in internal memory, 
then the button is inactive. You can display songs on your console and 
expansion cards at the same time.

• Card 1  or Card 2 . Select one of the Card buttons to display 
songs stored on an expansion card that is seated in an expansion slot. 
If there are no songs on the card seated in the expansion slot, then the 
button is inactive. You can display songs on your console and 
expansion cards at the same time.

• Details . View the following information when available: song title, 
artist name, album title, progress bar, counter.

• List . View the order in which songs will play and the location 
where the songs are stored. You can drag and drop song titles to 
arrange them in a particular order, or use the Music application on 
your computer to create a song list, and then synchronize your console 
with your computer. See the Palm Desktop Online Help for details.

TIP:TIP:TIP:TIP: To scroll through the song list, tap the onscreen scroll arrows or press the 
blue or green Action buttons. To play a specific song, tap List  and then 
tap the song title.
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Uploading Uploading Uploading Uploading songs songs songs songs from your from your from your from your computercomputercomputercomputer
Use the Music application in Palm™ Desktop software to choose which songs 
you want to upload and to arrange them in the order in which you want to 
play them on your console. During synchronization, Music copies the songs 
from your computer to your console or to any available expansion cards in the 
your console’s expansion slots.

1. Double-click the Palm Desktop icon on your computer desktop.

2. Click the Music button on the left side of the screen.

3. Click Add Song.

4. In the Open dialog box, locate and select a song.

5. Click Open to add this song to the list. 

The song title and performer's name appear in the list, along with a HotSync 
“pending” icon.

6. Repeat steps 3 through 5 to add other songs to the list.

7. For each song, click the Location list and select Handheld or any available 
expansion card to indicate where you want to upload the song.

8. Perform a HotSync operation to load the selected songs onto your 
console. See page 144 for details.

TIP:TIP:TIP:TIP: You can also use a card reader and Windows Explorer to copy MP3 files to an 
expansion card. Once the songs are on the card simply insert the card into one of 
your console’s expansion slots to play them on your console.

For additional information about uploading songs and using the Music 
application on your computer, see the Palm Desktop online Help.
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DDDDeleting songseleting songseleting songseleting songs
When you delete a song, Music removes the song from your song list and 
deletes the song file from your console or expansion card. If you also have a 
copy of the song on your computer, it does not delete the copy on your 
computer. 

1. Tap the Menu icon .

2. From the Track menu, select Delete. 

3. From the Delete From pick list, select the location of the song you want to 
delete.

4. Highlight the song you want to delete, and then tap Delete.

5. Tap Yes to confirm deletion.

Conserving power while playing songsConserving power while playing songsConserving power while playing songsConserving power while playing songs
When your console is not plugged into a power outlet, you can put your 
console into a special power-saving Hold state to conserve battery power 
while playing songs. In the Hold state, the screen and backlight turn off while 
your songs continue to play.

If you forget to put your console in the Hold state, it automatically enters this 
state if the auto-shutoff interval expires while you’re listening to a song.
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1. Tap the Menu icon .

2. From the Options menu, select Hold. 

The LED blinks slowly to indicate that the Hold state is active.

TIP:TIP:TIP:TIP: You can also activate the Hold state by simultaneously pressing the Left and 
Right Trigger buttons.

3. To return your console to the normal operating state, press either the 

Power button  or the Home button .

TIP:TIP:TIP:TIP: You can also conserve power by listening to music through the headphones 
or amplified external speakers instead of playing music through the internal 
speakers.

Setting Music preferencesSetting Music preferencesSetting Music preferencesSetting Music preferences
Use the Music Preferences dialog box to choose background, bass level, and 
color settings.

1. Tap the Menu icon .

2. From the Options menu, select Preferences.

3. In the Preferences dialog box, choose from the following settings:



Using Music
Setting Music preferences

Using Your Zodiac Console 58585858

• Background Playback. Listen to music while you play games, read an 
eBook, or use other applications on your console. 

When this box is checked you can tap the Music Controls icon  on 
the Status Bar to open the Music Controls dialog box and access the 
background playback controls. 

When this box is unchecked, your music stops playing when you exit 
the Music application.

NOTE:NOTE:NOTE:NOTE: Background playback may affect performance of some games. If you 
notice a decrease in performance while playing a game, try turning off music 
while playing this game.

• Stop Music on Exit. Pause music playback each time you exit the 
Music application. This option is available only when the Background 
Playback option is on. To resume playback, tap the Music Controls icon 

 on the Status Bar and use the controls in the Music Controls dialog 
box.

• Headphone Bass. Turn bass boost on and off. Tap the pick and choose 
Normal or Boost as the bass level setting.

• Color Theme. Set the background color for the Music application. To 
change the colors, tap the color box to open the Color Themes dialog 
box, tap a color theme, and then tap OK.

TIP:TIP:TIP:TIP: To create a custom color background, tap the pick list in the lower-right 
corner of the Color Themes dialog box and use the Palette, RGB, or HSV settings 
to create your own background.

4. Tap OK.
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UUUUsing sing sing sing PPPPhotohotohotohotossss
Photos provides a way to view and manage JPEG pictures files on your 
console.

Use Photos to: 

• View individual pictures stored on your console or an expansion card.

• View pictures and create slide shows.

• Upload pictures from your computer to your console or an expansion 
card.

• Update a picture list you created with the Photos component in Palm 
Desktop software.

• Exchange pictures with friends and family. See the section that begins 
on page 167 for details.

Opening PhotosOpening PhotosOpening PhotosOpening Photos
1. Press the Home button . 

2. Select the Media category .

3. Select the Photos icon .



Using Photos
Opening Photos

Using Your Zodiac Console 60606060

• Up . Select the thumbnail above the current picture, or display the 
previous picture in the sequence.

• Down . Select the thumbnail below the current picture, or display 
the next picture in the sequence.

• Left . Select the thumbnail to the left of the current picture, or 
display the previous picture in the sequence.

• Right . Select the thumbnail to the right of the current picture, or 
display the next picture in the sequence.

• Full-Screen . View a full-screen image of the selected picture. To 
exit Full-Screen mode, tap the screen or press Center.

• Slide Show . Begin a slide show. The pictures appear in Full-Screen 
mode in the same sequence as the picture list. The slide show 
automatically advances to the next picture after a preset interval. You 
can manually advance or rewind the slide show using the analog 
controller, the Action buttons, or the Trigger buttons.

• Shuffle . Select Shuffle to create a randomly ordered picture list 
and slide show. Deselect Shuffle to return the pictures to their prior 
order.

• Console . Select console to display pictures stored in the internal 
memory on your console. If there are no pictures in internal memory, 
then the button is inactive. You can display pictures on your console 
and expansion cards at the same time.

• Card 1  or Card 2 . Select one of the Card buttons to display 
pictures stored on an expansion card that is seated in an expansion 
slot. If there are no pictures on the card seated in the expansion slot, 
then the button is inactive. You can display pictures on your console 
and expansion cards at the same time.

• Picture List . Display thumbnail images of all the pictures in the 
selected locations. View the order in which pictures will appear in a 
slide show. You can drag and drop pictures to arrange them in a 
particular order, or use the Photos application on your computer to 
create a picture list, and then synchronize your console with your 
computer. See the Palm Desktop Online Help for details.
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• Details . View the selected picture and the following information 
and controls:

– Rotate controls . Rotate the picture in 90 degree 
increments.

– Fit controls . Choose how the picture fits on the screen. If 
the picture is smaller than your console’s screen (480x320 pixels), a 

 appears as a third fit control. You can use this extra control to 
view a small image at its actual size.

– Title. View the name of the picture file.

– Date/Time. View the date and time the picture was taken. This may 
be different from the date associated with the picture file.

– Location. View an icon that indicates where the picture is stored.

TIP:TIP:TIP:TIP: You can scroll to the next or previous picture using the analog 
controller, the Action buttons, or the Trigger buttons.
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Uploading pictures from your computerUploading pictures from your computerUploading pictures from your computerUploading pictures from your computer
Use the Photos application in Palm™ Desktop software to choose which 
pictures you want to upload and to arrange them in the order in which you 
want to view them on your console. During synchronization, Photos copies 
the pictures from your computer to your console or to any available 
expansion cards in the your console’s expansion slots.

1. Double-click the Palm Desktop icon on your computer desktop.

2. Click the Photos button on the left side of the screen.

3. Click Add File.

4. In the Open dialog box, locate and select a picture.

5. Click Open to add this picture to the list. 

The picture title appears in the list, along with a HotSync “pending” icon.

6. Repeat steps 3 through 5 to add other pictures to the list.

7. For each picture, click the Location list and select Handheld or any 
available expansion card to indicate where you want to upload the 
picture.

8. Perform a HotSync operation to load the selected songs onto your 
console. See page 144 for details.

TIP:TIP:TIP:TIP: You can also use a card reader and Windows Explorer to copy JPG files to an 
expansion card. Once the pictures are on the card simply insert the card into one of 
your console’s expansion slots and open Photos to view them on your console.

For additional information about uploading pictures and using the Photos 
application on your computer, see the Palm Desktop Online Help.
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SSSSetting Photos preferencesetting Photos preferencesetting Photos preferencesetting Photos preferences
1. From the list or detail view, tap the Menu icon .

2. From the Options menu, select Preferences. 

3. In the Preferences dialog box, choose from the following settings:

• Slide Duration. Indicate how quickly the pictures in a slide show 
change. Tap the pick list to select the interval unit: Seconds, Minutes, 
or Hours. Then enter the interval length in the space next to the pick 
list.

• Color Theme. Set the background color for the Photos application. To 
change the colors, tap the color box to open the Color Themes dialog 
box, tap a color theme, and then tap OK.

TIP:TIP:TIP:TIP: To create a custom color background, tap the pick list in the lower-right 
corner of the Color Themes dialog box and use the Palette, RGB, or HSV settings 
to create your own background.

4. Tap OK.

Deleting picturesDeleting picturesDeleting picturesDeleting pictures
When you delete a picture, Photos removes the picture from your picture list 
and deletes the file from your console or expansion card. 

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: If you also have a copy of the picture on your computer, 
deleting the picture from your console does NOT delete the copy on 
your computer. 
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Deleting a single pictureDeleting a single pictureDeleting a single pictureDeleting a single picture
1. From the list view, select the picture you want to delete.

2. Tap the Menu icon .

3. From the Image menu, select Delete Selected.

4. Tap Yes to confirm deletion.

Deleting multiple picturesDeleting multiple picturesDeleting multiple picturesDeleting multiple pictures
1. From the list or detail view, tap the Menu icon .

2. From the Image menu, select Delete. 

3. Select the picture you want to delete.

4. Tap Delete.

5. Tap Yes to confirm deletion.

6. Repeat steps 3 - 5 to delete other pictures.

7. Tap Done.
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Copying picturesCopying picturesCopying picturesCopying pictures
You can copy pictures between your console and an expansion card. 

1. From the list or detail view, tap the Menu icon .

2. From the Image menu, select Copy.
 

3. From the Copy From pick list, select the location where the picture 
currently resides.

4. From the Copy To pick list, select the location where you want to place the 
picture.

5. Select the picture you want to copy.

6. Tap Copy.

7. Repeat steps 3 - 6 to copy other pictures.

8. Tap Done.
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Playing Playing Playing Playing GamesGamesGamesGames
Your Zodiac console comes with these two great games:

• Stuntcar Extreme. Navigate hills, jumps and obstacles in this 
outrageous racing game, with graphic acceleration. Select from 
cockpit or behind the car view, and choose from a quick race or play an 
entire season in our championship mode. You can even see your stats 
track by track as you progress in the game. 

For complete documentation on this game, look for the PDF file in the 
Tapwave Extras\Bonus\Stuntcar Extreme\ folder on the Zodiac CD.

• Acid Solitaire. This addictive game offers the best of interactive 
solitaire for your on-the-go lifestyle. Supporting features such as an 
easy-to-use drag and drop interface, two play modes, an advanced 
statistic tracking model that follows eleven different game stats, and a 
sophisticated alert system that notifies you both when you are about 
to run out of moves and when no moves are remaining. You can even 
customize your background to have your own unique solitaire 
experience.

For complete documentation on this game, look for the PDF file in the 
Tapwave Extras\Bonus\Acid Solitaire\ folder on the Zodiac CD.

For information about installing additional games, see page 49. To learn about 
playing games that are stored on expansion cards, see page 159.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: Some games require special installation tools. Check the README 
file for your game to see if you can use the Palm Install Tool or if you need a 
special installation tool.
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PPPPlaying multilaying multilaying multilaying multipppplayer gameslayer gameslayer gameslayer games
The built-in Bluetooth radio provides you with a wireless, multiplayer gaming 
environment. When your console is within range of other Zodiac consoles or 
other devices enabled with Bluetooth technology that support the game 
software, you can initiate or join a multiplayer game session.

You can initiate a session as follows:

1. Launch the game. See page 43 for details.

2. Select multiplayer mode as described in the game documentation. 

This should initiate the discovery process on your console.

3. Instruct all players to quickly press and release the Bluetooth button  to 
make their consoles discoverable. 

When a Zodiac console is in this state, the Bluetooth LED flashes.

4. When the Discovery Results screen appears, select the players you want 
to include in the game, and then tap OK.

This should send an invitation message to the selected players’ consoles.

5. Instruct the players to tap Yes to join the game.

6. When the game is over, instruct all players to press and hold the 

Bluetooth button  to turn off the Bluetooth radio.

For additional information about using the Bluetooth features of your console 
visit tapwave.com.

http://www.tapwave.com
http://www.tapwave.com
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Using Using Using Using CCCCloclocloclockkkk
Clock provides an easy-to-read time display, an alarm clock, a stopwatch, and 
a timer. 

Use Clock to: 

• Set an alarm that is not related to a specific entry on your console.

• Determine how long it takes to complete a task or event.

• Receive a notification when the specified time period elapses.

Opening ClockOpening ClockOpening ClockOpening Clock
1. Press the Home button . 

2. Select the My Stuff category .

3. Select the Clock icon .

TIP:TIP:TIP:TIP: To set the time and date, select Set Time & Date from the Options menu.
To change the time and date format, tap Home , select the Prefs category, 
and then select Formats.

Analog clock
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• Analog Clock. View the current time in analog format. 

• Date. View the current date. 

• Time/Alarm . View the time in digital format and access the 
following alarm controls:

– Alarm On. Turn on the alarm and display the alarm controls.

– Alarm Off. Turn off the alarm and hide the alarm controls.

– Time. Set the time when you want the alarm to sound. When you 
tap this box, a number pad appears. Tap the numbers to select the 
time you want the alarm to sound, and then tap the Check button.

– Volume. Select the volume level for the alarm sound. The choices 
are: Low, Medium, High, and Ascending. The Ascending setting 
increases from low to high volume over a period of about 20 
seconds.

– Wake To. Select the alarm sound. Options include Music or a list of 
sample alarms. If you select Music, you can select a song from the 
Music application.

• Timer/Stopwatch . Access the following timer and stopwatch 
controls:

– Display. View the time remaining in timer mode, and the elapsed 
time in stopwatch mode. The time displays in 1/100th of a second 
increments.

– Start. Begin the timer or stopwatch. When you tap this button, it 
changes to a Stop button.

Display
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TIP:TIP:TIP:TIP: When the stopwatch is running, your console does not go to sleep. 
Make sure you stop or pause the stopwatch when you’re not using it to avoid 
accidentally draining the battery.

– Stop. Pause the timer or stopwatch. When you tap this button, it 
changes to a Resume button and a Reset button appears next to 
the Display. If you are done timing the current task, tap Reset to 
return the display to all zeros.

– Resume. Restart the timer or stopwatch to continue timing a task. 
When you tap this button it changes to a Stop button.

– Timer. Set a timer to notify you when a particular amount of time 
has passed. To set the timer, tap the number pad to indicate the 
time period you want to monitor, such as a 3-minute egg or a half-
hour pizza delivery. When the time period elapses, the selected 
alarm sound plays and a notification screen appears. You can set 
the timer sound by selecting Preferences from the Options menu.

TIP:TIP:TIP:TIP: You can also stop or resume the timer or stopwatch by pressing the 
Right Trigger button. 
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Performing Common TasksPerforming Common TasksPerforming Common TasksPerforming Common Tasks
There are many tasks that are common to the applications found in the 
Organizer category. These common tasks are described in this section. We use 
the term records as a generic term that refers to an individual item in an 
application, for example, a single Date Book event, an Address Book entry, a 
To Do List item, or a Memo Pad memo. 

Creating Creating Creating Creating rrrrecordsecordsecordsecords
You can use the following procedure to create a new record in Date Book, 
Address Book, To Do List, and Memo Pad.

1. Open the application in which you want to create a record.

2. Tap New. 

3. (Date Book only) Select start and end times for your appointment and 
tap OK.

4. Enter text for the record.

NOTE:NOTE:NOTE:NOTE: The console automatically capitalizes the first letter of each field 
(except numeric and e-mail fields). 

5. (Optional) Tap Details to select attributes for the record.

6. (Address Book and Memo Pad only) Tap Done.

Your console saves the new record automatically.
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Editing Editing Editing Editing rrrrecordsecordsecordsecords
After you create a record, you can change, delete, or add new information at 
any time. When the screen is in edit mode, a blinking cursor appears within 
the information, and the information appears on a dotted line called an edit 
line. You can then enter text in any of the ways described in the chapter 
beginning on page 32.

Selecting TextSelecting TextSelecting TextSelecting Text
Select the text you want to edit using one of the following techniques:

• Double-tap a word in a field to select the word.

• Triple-tap any word on a line to select the entire line.

• Drag across a line of text to select some or all of the information, or 
drag down to select text across multiple lines.

Using the Using the Using the Using the EEEEdit menudit menudit menudit menu
The Edit menu is available from any screen where you enter or edit text. As a 
general rule, the Edit menu commands affect selected text. Any of the 
following commands may appear in the Edit menu, depending on the 
application you’re using: 

• Undo. Reverses the last action taken. 

• Cut. Removes a selection from its current location to memory. You can 
then paste the text into another area of the current application or into 
a different application.

Edit line 

Cursor
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• Copy. Copies a selection and moves it to memory. You can paste the 
selection into another area of the current application or into a different 
application.

• Paste. Inserts a selection from memory into an area you select. Paste 
produces no result if you have not used the Cut or Copy commands. 

• Select All. Selects all the text in the current record or screen. 

• Keyboard. Opens the onscreen keyboard. Tap Done to close the 
keyboard. 

• Graffiti 2 Help. Opens the Graffiti 2 character stroke screen.

Deleting Deleting Deleting Deleting rrrrecordsecordsecordsecords
You can delete records in any of the Organizer applications. 

1. Select the record you want to delete.

2. Do one of the following:

• From the Record menu, select Delete. The Delete command differs 
depending on the application you’re using, for example, Delete Event 
appears in the Record menu in Date Book, and Delete Item appears in 
To Do List. 

• In the Details dialog box of the application, tap Delete, and then tap 
OK.

• Delete the text of the record. 

NOTE:NOTE:NOTE:NOTE: In Date Book, deleting the text of a repeating event deletes all 
instances of the event. 

• In the Input Area, drag a diagonal line from the lower left to upper 
right to display the Command toolbar; then tap the Delete icon or 
draw a Graffiti 2 D in the text area.

A confirmation dialog box appears. 

Delete icon
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3. To archive a copy of the deleted file on your PC during the next HotSync 
operation, check the Save Archive box. 

4. Tap OK to delete the record. 

Purging Purging Purging Purging rrrrecordsecordsecordsecords
Over time, as you use Date Book and To Do List, you may accumulate records 
that are no longer useful. For example, events that occurred months ago 
remain in Date Book, and completed To Do List items remain in the list.

Outdated records take up memory on your console, so it’s a good idea to 
remove them by using Purge. If you think Date Book or To Do List records 
might prove useful later, you can purge them from your console and save 
them in an archive file. 

Purging is not available in Address Book or Memo Pad; delete records from 
these applications manually. 

1. Open the application from which you want to purge records. 

2. Tap the Menu icon .

3. From the Record menu, select Purge. 

4. From the confirmation dialog box, do the following:

• Date Book. Select an option from the Delete Events Older Than pick 
list —1 week, 2 weeks, 3 weeks or 1 month.

• Date Book and To Do list. Check the Save Archive Copy on PC box to 
save a copy of purged records in an archive file on your desktop. The 
records are transferred the next time you perform a HotSync 
operation.

5. Tap OK.

Categorizing Categorizing Categorizing Categorizing rrrrecordsecordsecordsecords
You can categorize records in Address Book, To Do List, and Memo Pad for 
easy retrieval (Date Book does not have categories). When you create a record, 
it is automatically assigned to the current category. For example, if you are in 
the All category, the record goes in the Unfiled category. A record can remain 
unfiled or it can be assigned to a category at any time. 
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Each application has a default set of categories: 

• Address Book includes a Business, Personal, and QuickList category.

• To Do List includes a Business, Personal, and All category.

• Memo Pad includes a Business, Personal, and All category.

You can rename or delete the default categories, and you can create new 
categories. Each application can have up to 15 categories.

Moving a record into a categoryMoving a record into a categoryMoving a record into a categoryMoving a record into a category
1. Select the record you want to categorize.

2. Tap Details (from the Address View screen, tap Edit first).

3. From the Category pick list, select the desired category.

4. Tap OK. 

Displaying a category of recordsDisplaying a category of recordsDisplaying a category of recordsDisplaying a category of records
1. Open one of the following applications: Address Book, To Do List, or 

Memo Pad application. 

2. From the pick list in the upper-right corner, select the category you want 
to display. 
 

Tap pick list Select a category
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Adding or editAdding or editAdding or editAdding or editinginginging categories categories categories categories
1. In Address Book, To Do List, or Memo Pad application, choose from the 

following options:

• From the pick list in the upper-right corner, select Edit Categories. 

• In Address Book, select a record, tap Edit, and then tap Details. From 
the Category pick list, select Edit Categories.

• In Memo Pad and To Do List, select a record from the list, and tap 
Details. From the Category pick list, select Edit Categories.

2. Select any of the following options:

• To create a new category, tap New, and enter a new name in the Input 
Area. Tap OK. 

• To rename a category, tap it in the list to select it. Tap Rename, enter a 
new name in the Input Area, and tap OK.

Edit Categories
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TIP:TIP:TIP:TIP: You can move records from multiple categories into a single category 
by renaming all discrete categories with a single category name. 

• To delete a category, tap it in the list to select it. Tap Delete.

3. Tap OK.

FFFFinding inding inding inding rrrrecords ecords ecords ecords 
Your console provides several ways to find information: 

• In all applications, starting with the current application, you can use 
the Find dialog box to locate the selected text.

• In Date Book, To Do List, and Memo Pad, you can use Phone Lookup to 
display the Address List screen and add the information from this list 
to a record.

• In Address Book, you can use the Look Up option to enter the first 
letters of a name to scroll immediately to that name.

Finding Address Book recordsFinding Address Book recordsFinding Address Book recordsFinding Address Book records
1. Do one of the following:

• From the Address screen, enter the first few letters of the name you 
want to locate. 

• Move the analog controller  to scroll to a name. Holding down the 
analog controller accelerates scrolling. 

Look Up line
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Using the Find dialog boxUsing the Find dialog boxUsing the Find dialog boxUsing the Find dialog box
The Find dialog box helps you locate text in any or all applications. For 
example, if the text “dog” appears in Address Book and Date Book, the Find 
dialog box displays both occurrences. 

1. Tap the Find icon.

2. Enter the text you want to find; then tap OK. 

Note that the Find option is not case sensitive; searching for "davidson" 
also finds "Davidson." 

TIP:TIP:TIP:TIP: Select text in an application before tapping Find to automatically place 
the text in the Find dialog box. 

Find searches for the text in all records and all notes within all applications. 

As your console searches for the text, you can tap Stop to stop the search at 
any time. To continue the search after tapping Stop, tap Find More.

NOTE:NOTE:NOTE:NOTE: Find locates all matches that begin with the supplied text. It does not 
find words where the supplied text appears in the middle or at the end of a word.

Using Phone LoUsing Phone LoUsing Phone LoUsing Phone Loooookup kup kup kup 
The Phone Lookup option lets you add a telephone number from the Address 
list to an entry in another application. For example, you can add your dentist’s 
telephone number to your dental appointment date in Date Book. 



Performing Common Tasks
Sorting records

Using Your Zodiac Console 79797979

1. In Date Book, To Do List, or Memo Pad, display the record in which you 
want to insert a phone number. 

2. Tap the Menu icon .

3. From the Options menu, select Phone Lookup. 

4. Select a record or write the first few letters of the name you want to add. 
Tap Add to add the information to the record.

NOTE:NOTE:NOTE:NOTE: You can also search based on selected text. Drag to highlight the text, 
then follow step 3 above. When the search is complete, the name and phone 
number of the candidate replaces the selected text.

Sorting Sorting Sorting Sorting rrrrecordsecordsecordsecords
You can sort lists of records in various ways, depending on the application. 
Sorting is available in applications that display lists—in Address Book, To Do 
List, and Memo Pad.

Sorting To Do List recordsSorting To Do List recordsSorting To Do List recordsSorting To Do List records
1. Open the application to display the list screen.

2. Tap Show.
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3. From the Sort By pick list, select an option.

4. Tap OK.

Sorting Address Book and Memo Pad recordsSorting Address Book and Memo Pad recordsSorting Address Book and Memo Pad recordsSorting Address Book and Memo Pad records
1. Open the application to display the list screen.

2. Tap the Menu icon .

3. From the Options menu, select Preferences. 

4. In the Preferences dialog box, tap the option you want, and then tap OK 
to sort the list. 

TIP:TIP:TIP:TIP: You can also manually arrange the Memo list by tapping and dragging 
a memo to a new location in the list. To display the list of your memos on your 
computer as you arranged them manually on your console, open Memo Pad 
in Palm Desktop software, click List By, and select Order on Handheld.

Sort By 
pick list
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Making Making Making Making rrrrecords privateecords privateecords privateecords private
In most applications (except Mail), you can make individual records private. 
Private records can be either masked or hidden. Private records remain visible 
and accessible until you select a security setting to Hide records. Private 
record names are covered with a gray bar when the security setting is set to 
Mask records.

If you assigned a password to your console, you must enter it before private 
records are displayed. For more information, see page 151.

1. In your application, do one of the following:

• Create a new record and tap Edit, and then tap Details.

• Select an existing record, and tap Details.

2. Check the Private box. Tap OK.

3. At the alert in the Private Records dialog box, tap OK.

HHHHiding private recordsiding private recordsiding private recordsiding private records
1. Do one of the following:

• Press the Home button , select the Utilities category, and then 
select Security.

• From within an application, tap the Menu icon , and from the 
Options menu, select Security. 

• From within any application, draw the Menu command stroke to bring 
up the Command Bar and tap the padlock icon.

2. From the Current Privacy pick list in the Change Security dialog box, 
select Hide Records.
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3. Tap OK.

DDDDisplaying private recordsisplaying private recordsisplaying private recordsisplaying private records
1. Do one of the following:

• Press the Home button , select the Utilities category, and then 
select Security.

• From within an application, tap the Menu icon , and from the 
Options menu, select Security. 

• From within any application, draw the Menu command stroke to bring 
up the Command Bar and tap the padlock icon.

2. From the Current Privacy pick list, select Show Records.

3. If you assigned a password, enter it. 

4. Tap OK.

Attaching Attaching Attaching Attaching nnnnotesotesotesotes
You can attach notes to records in all the Organizer applications except Memo 
Pad. A note can be up to several thousand characters long. 

1. Display the entry to which you want to add a note. 

2. (Address Book only) Tap Edit.

3. Tap Details. 



Performing Common Tasks
Attaching notes

Using Your Zodiac Console 83838383

4. Tap Note.

5. Enter the desired note. 

6. Tap Done.

A note icon appears to the right of any item containing a note. To review or 
edit a note, tap the note icon.

Deleting a noteDeleting a noteDeleting a noteDeleting a note
1. Tap the note icon.

2. Tap Delete.

3. Tap Yes. 

Note icon
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Choosing Choosing Choosing Choosing ffffontsontsontsonts
You can change the font style in all the Organizer applications. You can also 
choose a different font style for each application.

1. Open an application.

2. Tap the Menu icon . 

3. From the Options menu, select Font.

4. Tap the font style you want.

5. Tap OK.

Small font

Large font

Small bold font

Large bold font

Small LargeSmall bold

Large bold
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Using Address BooUsing Address BooUsing Address BooUsing Address Bookkkk
Address Book lets you keep names, addresses, telephone numbers, and other 
information about your personal or business contacts.

Use Address Book to: 

• Quickly enter, look up, or duplicate names, addresses, phone numbers, 
and other information.

• Enter up to five phone numbers (home, work, fax, mobile, and so on) or 
e-mail addresses for each name.

• Define which phone number appears in the Address List for each 
Address Book entry. 

• Attach a note to each Address Book entry, in which you can enter 
additional information about the entry.

• Assign Address Book entries to categories so that you can organize 
and view them in logical groups.

Opening Opening Opening Opening AAAAddress Bookddress Bookddress Bookddress Book
1. Press the Home button . 

2. Select the Organizer category .

3. Select the Address icon .

Address Book opens to display the list of all your records.
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Adding and using Address Book entriesAdding and using Address Book entriesAdding and using Address Book entriesAdding and using Address Book entries
Address Book stores name and address information about people or 
businesses.

Creating an Creating an Creating an Creating an AAAAddress Book entryddress Book entryddress Book entryddress Book entry
A record in Address Book is called an entry. You can create entries on your 
console, or you can use Palm Desktop software to create entries on your 
computer and then download them to your console with your next HotSync 
operation.

Palm Desktop software also has data import capabilities that let you load 
database files into Address Book on your console. See page 41 and Palm 
Desktop online Help for more information.

1. Open Address Book.

2. Tap New.
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3. Enter the last name of the person you want to add to your Address Book. 

4. Tap the First Name field and enter the person’s first name. 

5. Tap any field and enter any other information that you want to include in 
the entry.

NOTE:NOTE:NOTE:NOTE: If you plan to sort entries by company name, be sure to enter a company name. 

6. Tap the scroll arrows to move to the next page of information.

7. To attach a note to an entry, tap Note. Enter the note, and then tap Done.

8. After you finish entering information, tap Done.

TIP:TIP:TIP:TIP: To create an entry that always appears at the top of the Address List, 
begin the Last name or Company field with a symbol, as in *If Found Call.* 
This entry can contain contact information in case you lose your console.

Cursor 
at Last 
name

Tap here to assign 
entry to a category
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Viewing Viewing Viewing Viewing aaaan address entryn address entryn address entryn address entry
1. Tap the address entry in Address List view.

The entry appears in Address view.

2. Tap Done after you finish viewing the entry.

DDDDuplicating an entryuplicating an entryuplicating an entryuplicating an entry
You can duplicate existing entries, which can be helpful when you want to 
enter multiple people from a single organization. When you duplicate an 
entry, the word Copy appears next to the name in the First Name field. 

1. In Address Book, tap a name you want to duplicate.

2. Tap the Menu icon .

3. From the Record menu, select Duplicate Record. 

4. Edit the record as necessary. 

Selecting different Selecting different Selecting different Selecting different ttttypesypesypesypes o o o of f f f pppphone numbers and addresseshone numbers and addresseshone numbers and addresseshone numbers and addresses
You can select the types of phone numbers or e-mail addresses that an 
Address Book entry displays. Any changes you make apply only to the current 
entry. 

1. In the Address list, tap the entry you want to change. 

2. Tap Edit.

3. From the pick list next to any label you want to change, select a new label.
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Editing Address Book Editing Address Book Editing Address Book Editing Address Book eeeentriesntriesntriesntries
You can change the type of information that appears in the Address List 
screen, categorize an entry, and hide an entry for security reasons. You can 
also delete entries. 

1. Tap the entry that you want to change in the Address list.

2. Tap Edit.

3. Tap Details.

4. In the Address Entry Details dialog box, set any of the following:

• Show in List. Select which information you want to appear in the 
Address List screen. Options are Work, Home, Fax, Other, and E-mail. 

• Category. Select the category you want to assign to the entry.

• Private. Hide the entry when Security is turned on.

• Note. Attach a note, such as driving directions, to the entry.

5. Tap OK.
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Changing Changing Changing Changing AAAAddress Book displayddress Book displayddress Book displayddress Book display
You can change how Address Book lists are sorted and you can add custom 
fields for entering additional information, using preferences. You can also 
have Address Book display the last category you selected each time you 
return to the application.

1. In the Address list or in Address view, tap the Menu icon .

2. From the Options menu, select Preferences.
.

3. From the Address Book Preferences dialog box, select from the following 
options:

• Remember last category. Display the most recently viewed category 
the next time you open Address Book.

• Last Name, First Name. Sort the Address list alphabetically by an 
individual’s last name and then first name.

• Company, Last Name. Sort the Address list alphabetically by the 
company name, and then an individual’s last name.

4. Tap OK.

Adding Adding Adding Adding ccccustom fields at the end of Address Edit screensustom fields at the end of Address Edit screensustom fields at the end of Address Edit screensustom fields at the end of Address Edit screens
1. In the Address list or in Address view, tap the Menu icon .

2. From the Options menu, select Rename Custom Fields.



Using Address Book
Adding custom fields at the end of Address Edit screens

Using Your Zodiac Console 91919191

3. In the Input Area, rename the fields to identify the information you’ll 
enter in them. The names you give the custom fields appear in all entries, 
at the end of the Address Edit screen. 

4. Tap OK in the Rename Custom Fields dialog box.

5. Tap Done.
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Using Date BooUsing Date BooUsing Date BooUsing Date Bookkkk
Date Book lets you quickly and easily schedule appointments or any activity 
associated with a date or date and time. When you open Date Book, the 
current date and a list of times for a standard business day are displayed. 

Use Date Book to: 

• Schedule events: timed events, which have both times and dates; 
untimed events, for example, birthdays or anniversaries; repeating 
events, such as a weekly meeting held on the same day at the same 
time; continuous events, such as a vacation or three-day conference; 
and all day events, which reflect the default hours of a day as set by the 
user. 

• Display your schedule in different ways: by Day, Week, Month, or 
Agenda view. 

• Set an alarm to sound minutes, hours, or days before a scheduled 
appointment. 

• Attach notes to events to describe or clarify Date Book entries. 

• Rearrange or delete events from your schedule.

Opening Opening Opening Opening DDDDate Bookate Bookate Bookate Book
1. Press the Home button . 

2. Select the Organizer category .

3. Select the Date Book icon .

Date Book opens to today’s schedule. The date appears in the top left corner 
of the screen. 
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Scheduling Scheduling Scheduling Scheduling eeeeventsventsventsvents
An entry in Date Book is called an event. When you schedule an event, its 
description appears on the time line, and its duration is set to 1 hour by 
default. You can easily change the start time and duration for any event. You 
can schedule the following types of events in Date Book:

• Timed events, such as meetings, that have a specific date and a specific 
start and end time. 

• Untimed events, such as birthdays, holidays, and anniversaries. These 
events occur on a particular date but have no specific start or end 
times; they appear at the top of the list of times marked with a 
diamond. You can schedule more than one untimed event on the 
same date. 

• Repeating events, such as a weekly meeting that is held on the same 
day at the same time each week. 

• Continuous events, such as a vacation or three-day conference.

• All day events, which reflect the default length of the day. 
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Scheduling timed Scheduling timed Scheduling timed Scheduling timed eeeevents for the current datevents for the current datevents for the current datevents for the current date
1. Open Date Book to today’s schedule. The Day view displays the current 

date and a list of times for a normal day.

2. With the current day selected, tap the line next to the time that 
corresponds to the start of the event. 

3. Enter a description of the event, up to 255 characters in length.

4. Set the event’s duration:

• If the event is one hour long, skip to the end of this procedure.

• If the event is longer or shorter than an hour, tap directly on the time to 
open the Set Time dialog box.

Time bar shows 
default duration

Enter text next 
to event time

Tap the time to 
display the Set 
Time dialog box
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TIP:TIP:TIP:TIP: You can open the Set Time dialog box (to select a start time) by making 
sure no event is selected, and then writing a number in the number portion of 
the Input Area.

5. Set the duration of the event in either of the following ways:

• Tap the time columns in the Set Time dialog box to set the Start Time; 
Tap End Time; then tap the time columns to set the End Time.

• Tap All Day if the event lasts all day. The default hours of a standard 
business day are set by the user, and may be changed using Date Book 
Preferences. For details, see page 108.

6. Tap OK.

Tap to scroll to 
earlier hours

Tap to scroll to 
later hours

Tap to change 
hours

Tap to change 
minutes
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Scheduling a timed event for another dateScheduling a timed event for another dateScheduling a timed event for another dateScheduling a timed event for another date
1. Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of the screen. 
If necessary, tap the scroll arrows in the upper-right corner to move to 
the next or previous week.

• Move the analog controller  to scroll between days. Move Left to 
display the previous day and Right to display the next day. 

• Tap Go To at the bottom of the screen to open the Go to Date dialog 
box. Select a date by tapping a year, month, and day in the calendar.

2. After locating the desired date, follow the steps for scheduling an event 
for the current day.

Scheduling untimed Scheduling untimed Scheduling untimed Scheduling untimed eeeeventsventsventsvents
You can schedule untimed events for any date. Untimed events appear at the 
top of the list of times marked with a diamond. 

1. Select the event date you want (see page 93).

2. Tap New.

3. In the Set Time dialog box, tap No Time. 

NOTE:NOTE:NOTE:NOTE: You can tap OK instead but make sure nothing is entered for start 
or end time.
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TIP:TIP:TIP:TIP: You can create a new untimed event by making sure no event is selected 
and then writing letters in the Input Area. When you start writing, the untimed 
event appears at the top of the screen 

4. Enter a description of the event.

5. Tap a blank area on the screen to deselect the untimed event.

NOTE:NOTE:NOTE:NOTE: If you create a timed event and later want to make it an untimed event, 
tap directly on the event time in Date Book, tap No Time, and then tap OK. 

Adding Address Book information to an eventAdding Address Book information to an eventAdding Address Book information to an eventAdding Address Book information to an event
You can add a name, address, and telephone number to an event using the 
Phone Lookup option. For instructions, see page 78.

Rescheduling eventsRescheduling eventsRescheduling eventsRescheduling events
You reschedule events using the Details option in Date Book. You can also use 
the Details option to convert untimed events into timed events. 

1. Tap the event you want to reschedule.

2. Tap Details.

3. To change the time, tap the Time box, select a new time, and then tap OK. 

4. To change the date, tap the Date box, select a new date, and then tap OK.

Untimed 
event
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Scheduling repeating or continuous Scheduling repeating or continuous Scheduling repeating or continuous Scheduling repeating or continuous eeeevents vents vents vents 
The Repeat function lets you schedule events that recur at regular intervals or 
extend over a period of consecutive days. Repeating events include a birthday 
and a weekly guitar lesson that falls on the same day of the week and the 
same time of day. Continuous events might include a business trip or a 
vacation.

1. Tap the event (be sure to tap the event and not the time next to the event). 

Typically, a continuous event is an untimed event.

2. Tap Details.

3. Tap the Repeat box to open the Change Repeat dialog box.

4. Tap Day, Week, Month, or Year to set how often the event repeats. For a 
continuous event, tap Day.

5. Enter a number that corresponds to how often you want the event to 
repeat on the Every line. 

6. For example, if you select Month and enter the number 2, the event 
repeats every other month.

7. To set an end date for the repeating or continuous event, select Choose 
Date from the End On pick list. Use the date picker to select an end date.

8. Tap OK. An icon that represents a repeating event appears to the far right 
on the event line.

Tap the 
Repeat 
box
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Changing repeating or continuous eventsChanging repeating or continuous eventsChanging repeating or continuous eventsChanging repeating or continuous events
When changes are made to a repeating or continuous event you have the 
option of applying the change to just the current event, the current event and 
all future occurrences of this event, or all occurrences of this event—past, 
present, and future.

1. Select the event you want to change and tap Details.

2. Change the event and tap OK. The Repeating Event screen opens.

3. Select one of the following options:

• Current. Edit a single occurrence of this event.

• Future. Edit the current event and all future occurrences of this event.

• All. Edit all past, current, and future occurrences of this event.

The event is changed and you are returned to the day view where you started. 
These steps apply to all changes and deletions you make to repeating or 
continuous events.

Tips for scheduling repeating or continuous events

Keep the following in mind when scheduling repeating or continuous events:

• If you change the start date of a repeating event, your console 
calculates the number of days you moved the event. Your console 
then automatically changes the end date to maintain the duration of 
the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a repeating 
event, past occurrences (prior to the day on which you change the 
setting) are not changed, and your console creates a new repeating 
event.
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• If you change the date of an occurrence of a repeating event (e.g., from 
January 14 to January 15) and apply the change to all occurrences, the 
new date becomes the start date of the repeating event. Your console 
adjusts the end date to maintain the duration of the event.

• If you change other repeat settings (for example, time, alarm, private) 
of a repeating event and apply the change to all occurrences, your 
console creates a new event. The start date of this new event is the day 
on which the setting is changed. Past occurrences (prior to the day of 
the change) are not changed.

• If you apply a change to a single occurrence of a repeating event (e.g., 
time), that occurrence no longer shows the Repeat icon.

SSSSetting the etting the etting the etting the aaaalarmlarmlarmlarm
The Alarm setting lets you set an audible alarm for events in your Date Book, 
and display a reminder message on-screen. For untimed events, only the 
reminder message appears.

Setting an alarm for an eventSetting an alarm for an eventSetting an alarm for an eventSetting an alarm for an event
You can set an alarm for minutes, hours, or days before an event. When you 
set an alarm, an Alarm icon appears to the far right of the event with the 
alarm. 

You can also set a silent alarm for untimed events that displays a reminder 
message on-screen before the day of the event. The alarm triggers at the 
specified period of minutes, hours, or days before midnight of the day on 
which the untimed event begins. 

For example, you set a 5-minute alarm for an untimed event that occurs on 
February 4. The reminder message appears at 11:55 p.m. on the night of 
February 3. The reminder remains onscreen until you turn on your console 
and tap OK to turn off the reminder.

1. Tap the event to which you want to assign an alarm.

2. Tap Details.

3. Check the Alarm box.

The default setting, 5 Minutes, appears.
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4. Set the alarm time:

• Enter any number from 0 to 99 (inclusive) as the number of time units.

• From the pick list, select the time unit --Minutes, Hours, or Days.

5. Tap OK.

Once an alarm goes off, you can tap the Snooze option to dismiss the alarm 
for a 5-minute period. 

Snoozing the alarmSnoozing the alarmSnoozing the alarmSnoozing the alarm
When the alarm dialog box appears, tap Snooze to delay the alarm for a preset 
five-minute period. 

Each time you tap Snooze, the alarm dismisses for an additional 5-minute 
period. 

Unit of time

Number of 
time units
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Setting alarm optionsSetting alarm optionsSetting alarm optionsSetting alarm options
You can set the alarm to go off automatically for each new event using 
preferences. You can also set a tone for the alarm and the number of times the 
alarm sounds. 

1. In Date Book, tap the Menu icon .

2. From the Options menu, select Preferences.

3. Select from the following options: 

• Alarm Preset. Set an alarm for each new event automatically. The 
silent alarm for untimed events is defined by minutes, days, or hours 
before midnight of the date of the event. 

• Alarm Sound. Select the tone of the alarm. Options include Alarm, 
Alert, Bird, Concerto, Phone, Sci-fi, and Wake Up.

• Remind Me. Define how many times the alarm sounds—once, twice, 
three, five, or ten times.

• Play Every. Set how often the alarm sounds—every 1, 5, 10, or 30 
minutes.

4. Tap OK.
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Changing the Changing the Changing the Changing the DDDDate Book viewate Book viewate Book viewate Book view
Date Book includes four views for displaying your appointments: day view, 
week view, month view, and agenda view. 

• Tap a view icon in the lower-left corner of the Date Book screen.

• Press the Function button to scroll between views.

• Tap and hold down the stylus on the date in the date bar to display the 
time (when you release the stylus, the menu bar appears). 

Working in Working in Working in Working in WWWWeek vieweek vieweek vieweek view
Week view displays a calendar of your events for an entire week. This view lets 
you quickly review your appointments and available time slots. In addition, 
the graphical display helps you spot overlaps and conflicts in your schedule.

Displaying the Week view

• Tap the Week view icon . 

Date Book 
view icons

Previous 
week

Next 
week

Tap column to view that day

Box indicates 
event 

Bar indicates 
earlier event

Dot indicates untimed event

Bar indicates 
later eventMonth View icon
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Tips for using Week view

Keep the following points in mind when using Week view: 

• Tap a specific day to display that day in Day view.

• Tap an event to display a description of the event at the top of the 
screen.

• Tap the scroll arrows in the upper-right corner or move the analog 
controller  Right or Left to scroll forward or backward a week at a 
time.

• To reschedule an event while in Week view, tap and drag the event to a 
different time or day.

• Tap a blank time on any day to move to that day and have the time 
selected for a new event. 

• Tap any day or date that appears at the top of the Week view to move 
directly to that day without selecting an event.

• The Week view displays the time span defined by the Start Time and 
End Time in Date Book Preferences. If you have an event before or after 
this time span, a bar appears at the top or bottom of that day's column. 
Use the onscreen scroll arrows to scroll to the event.

Event details

Tap to show 
event details
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Working in Working in Working in Working in MMMMonth viewonth viewonth viewonth view
The Month view screen shows which days have events scheduled. Dots and 
lines in the Month view indicate events, repeating events, and untimed 
events.

Displaying the Month view

• Tap the Month view icon . 

You can control the dots and lines that appear in the Month View. See page 
107 for more information.

Tips for using Month view

Keep the following points in mind when using the Month view: 

• Tap a day in the Month view to display that day in the Day view.

• Tap the scroll arrows in the upper-right corner to move forward or 
backward a month, or when no date is selected, move the analog 
controller  Left to display the previous month and Right to display 
the next month.

• Move the analog controller  to scroll between days and months. 
When a date is selected, move Left to display the previous day and 
Right to display the next day. 

• Tap Go To to open the date selector and select a different month.

Previous/next month

Bar on right 
side indicates 
event

Dashed line 
indicates 
continuous 
event

Plus below 
date indicates 
untimed event

Month View icon
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Working in Agenda viewWorking in Agenda viewWorking in Agenda viewWorking in Agenda view
The Agenda view lets you view appointments, untimed events, and To Do List 
items in a single screen. Although it is primarily a viewing option, you can also 
use the Agenda view to check off completed To Do List items. To go to a Day 
View of any event on the Agenda view screen, simply tap the desired event. 

Displaying the Agenda View

• Tap the Agenda view icon .

Tips for using Agenda view

• Tap the scroll arrows in the upper-right corner or move the analog 
controller  Right or Left to scroll forward or backward a day at a time 
or to display more To Do items.

• Tap any appointment while in Agenda view to display the Day View of 
the appointment. 

• Check off completed To Do List items in the Agenda view, or tap a 
description of an item to go directly into To Do List. 

• You can change the category of To Do items shown. From the pick list, 
select the new category. See the chapter that begins on page 113 for 
more information on To Do items.

Scroll the list 
for each view

Agenda view icon
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Spotting Spotting Spotting Spotting eeeevent conflictsvent conflictsvent conflictsvent conflicts
With the ability to define specific start and end times for any event, it is 
possible to schedule events that overlap (an event that starts before a 
previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping time 
bars and in the Day view as overlapping brackets to the left of the conflicting 
times.

Changing the Date Book displayChanging the Date Book displayChanging the Date Book displayChanging the Date Book display
In Day or Month view, you can change which events appear in Date Book. In 
Day view, you can display time bars that highlight event conflicts.

1. In Day view or Month view, tap the Menu icon .

2. From the Options menu, select Display Options.

Event 
conflict
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3. For Day view, select from the following options:

• Show Time Bars. Display time bars showing the duration of an event 
and any event conflicts.

• Compress Day View. Display start and end times for each event, but 
no blank time slots at the bottom of the screen, to minimize scrolling. 
Clear the option to display all time slots. 

4. For Month view, select from the following options.

• Show Timed Events. Display time bars for events.

• Show Untimed Events. Display plus symbols for untimed events.

• Show Daily Repeating Evts. Display dashed lines for continuous 
events.

5. Tap OK.

Changing the displayed Start and End TimesChanging the displayed Start and End TimesChanging the displayed Start and End TimesChanging the displayed Start and End Times
You can change the preferences used for new entries. Preferences include 
display starting time, display ending time, and alarm characteristics. See page 
102 for more information on alarm preferences.

1. In Date Book, tap the Menu icon .

2. From the Options menu, select Preferences.
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The Start and End Time are used by the various Date Book screens. The Day 
view schedules events to start and end at these times when the All Day option 
is selected. The Week view displays the time span defined by the Start Time 
and End Time.

3. Tap Start Time and use the scroll arrows to select a new start time for Date 
Book screens. Repeat the step to set a new end time. If the time slots you 
select do not fit on one screen, you can tap the scroll arrows to scroll up 
and down.

4. Tap OK.
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Using Using Using Using MMMMemo Paemo Paemo Paemo Padddd
Memo Pad provides a place to take notes that are not associated with records 
in your other applications.

Use Memo Pad to: 

• Take notes or write any kind of message on your console. 

• Assign memos to categories so that you can organize and view them in 
logical groups.

• Write down phone numbers and other types of information. Later, you 
can copy and paste this information into other applications. 

Opening Memo PadOpening Memo PadOpening Memo PadOpening Memo Pad
1. Press the Home button . 

2. Select the Organizer category .

3. Select the Memo Pad icon .

Memo Pad opens to display the last Memo Pad screen that you viewed.
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CCCCreating reating reating reating mmmmemosemosemosemos
A record in Memo Pad is called a memo. A memo can contain up to 4,000 
characters. The number of memos you can store is limited only by the 
memory available on your console.

When you create a new memo, you can add information to it from Address 
Book, such as a phone number or address, using the Phone Lookup option. 
For details, see page 78.

1. Open Memo Pad.

2. Tap New.

TIP:TIP:TIP:TIP: You can also create a new memo by beginning to write in the Input Area 
in the Memo List screen. The first letter is automatically capitalized and begins 
your new memo. 

3. Enter the text you want to appear in the memo. Use the carriage return 
stroke to move down to new lines in the memo.

4. Tap Done. 

You can categorize memos and sort them by categories. See the sections that 
begin on page 74 and page 79 for more information.



Using Memo Pad
Reviewing memos

Using Your Zodiac Console 112112112112

Reviewing Reviewing Reviewing Reviewing mmmmemosemosemosemos
The Memo List displays the first line of a memo. This makes it easy to locate 
and review your memos. You can easily sort memos in the Memo List or move 
through memos using Memo options.

1. In the Memo List, tap the text of the memo.

2. Review or edit the text in the memo. 

3. Tap Done.

Arranging Arranging Arranging Arranging tttthe Memo Listhe Memo Listhe Memo Listhe Memo List
1. In the Memo List, tap the Menu icon .

2. From the Options menu, select Preferences.

3. Select one of the following options:

• Manual. Sort new memos in the sequence in which you create them.

• Alphabetical. Sort new and existing memos in numerical and then 
alphabetical sequence. 

4. Tap OK.

Tap a 
memo to 
review its 
contents
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Using To Do LisUsing To Do LisUsing To Do LisUsing To Do Listttt
To Do List is a convenient place to create reminders and prioritize the things 
that you have to do.

Use To Do List to: 

• Make a quick and convenient list of things to do.

• Assign a priority level to each task.

• Assign a due date for any or all of your To Do List items. 

• Assign To Do List items to categories so that you can organize and 
view them in logical groups (see page 74).

• Sort your To Do List items either by due date, priority level, or category.

• Attach notes to individual To Do List items for a description or 
clarification of the task (see page 82).

Opening Opening Opening Opening TTTTo Do Listo Do Listo Do Listo Do List
1. Press the Home button . 

2. Select the Organizer category .

3. Select the To Do List icon .

To Do List opens to display the category of items you last viewed.
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CCCCreating reating reating reating TTTTo Do List itemso Do List itemso Do List itemso Do List items
A To Do List item is a reminder of some task that you have to complete. A 
record in To Do List is called an item.

1. Open To Do List.

2. Tap New.

3. Enter the text of the To Do List item. The text can be longer than one line.

TIP:TIP:TIP:TIP: You can add a name, address, and phone number to a To Do List item 
using the Phone Lookup option. For more information, see page 78.

4. Tap anywhere onscreen to deselect the To Do List item.

TIP:TIP:TIP:TIP: If no To Do List item is currently selected, writing in the Input Area 
automatically creates a new item.

New To 
Do item
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Setting To Do List Setting To Do List Setting To Do List Setting To Do List pppprioritiesrioritiesrioritiesriorities
You can set priorities for tasks in your To Do List according to their importance 
or urgency. By default, items appear by priority and due date, with 1 as the 
highest priority. Changing an item’s priority may move its position in the list. 

New To Do List items automatically have a priority of 1. If you select another 
item first, before creating a new item, the item you create appears beneath 
the selected item with the same priority as the selected item. 

1. If priorities aren’t visible in To Do List, tap Show at the bottom of the list, 
tap Show Priorities, and tap OK.

2. Tap the Priority number on the left side of the To Do List item.

3. Tap the Priority number that you want to set. 1 is the most important and 
5 is the least important. 

Tap to 
select 
priority
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Checking off Checking off Checking off Checking off TTTTo Do List itemso Do List itemso Do List itemso Do List items
You can check off a To Do List item to indicate that you’ve completed it. 

1. In To Do List, tap Show. 

2. Check the Show Completed Items box. 

NOTE:NOTE:NOTE:NOTE: If you uncheck this setting, your To Do items disappear from the list 
when you complete (check) them. Items that no longer appear on the list 
because Show Completed Items is turned off have not been deleted. They 
are still in the memory of your console. You must purge completed items 
to remove them from memory.

3. Check the box on the left side of the item.

Completed 
To Do item
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Changing priorities and due datesChanging priorities and due datesChanging priorities and due datesChanging priorities and due dates
You can change To Do List to display the due date assigned to an item, change 
its priority, and assign a category to the task with the To Do Item Details 
dialog box. 

You can then sort To Do List items by priority, due date, or category.

1. In To Do List, tap the item that you want to change.

2. Tap Details.

3. From the Due Date pick list, select the date that you want to assign the 
item. Options are Today, Tomorrow, One Week from the current date, No 
Date (removes the due date from the item), or Choose Date (displays a 
dialog box for you to select a date). 

4. Tap Private to hide this item when Security is turned on.

For more information on hiding private records, see page 81.

5. Tap OK.

TIP:TIP:TIP:TIP: If you turn on the Show Due Dates option in the To Do Preferences 
dialog box, you can tap directly on the due date in To Do List to open the 
pick list shown in step 2.
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Sorting To Do itemsSorting To Do itemsSorting To Do itemsSorting To Do items
1. In To Do List, tap Show.

2. From the Sort By pick list, select an option:

• Priority, Due Date. Sort items by priority first, and then due date. 

• Due Date, Priority. Sort items by due date first, and then priority.

• Category, Priority. Sort items by category first, and then priority. 

• Priority, Category. Sort items by priority first, and then category. 

3. Tap OK.

Setting Setting Setting Setting TTTTo Do List preferenceso Do List preferenceso Do List preferenceso Do List preferences
You can have To Do List display completed items and their completion dates, 
as well as due items and their due dates. 
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1. In To Do List, tap Show.

2. In the To Do Preferences dialog box, choose from the following settings:

• Show Completed Items. Display your completed items in To Do List. If 
this box is unchecked, completed To Do items disappear from the list, 
but are kept in the memory of your console. You must purge 
completed items to remove them from memory.

• Show Only Due Items. Show only the items that are currently due, 
past due, or have no due date specified. When this box is checked, 
items that are not yet due do not appear in the list until their due date.

• Record Completion Date. Replace the due date with the actual 
completion date (when you check the item). If you do not assign a due 
date, the completion date still records when you complete the item.

• Show Due Dates. Display the due dates for items in To Do List, and 
display an exclamation mark next to items that remain incomplete 
after the due date passes.

• Show Priorities. Display the item priority to the left of each item in To 
Do List.

• Show Categories. Display the category to which the item is assigned 
to the right of each item in To Do List.

3. Tap OK.



Using Your Zodiac Console 120120120120

13
Using Using Using Using CCCCalculatoalculatoalculatoalculatorrrr
Calculator lets you perform general mathematical functions, such as addition, 
subtraction, multiplication, and division. 

Use Calculator to: 

• Perform basic calculations.

• Store and retrieve values.

• Display the last series of calculations, which is useful for confirming a 
series of “chain” calculations.

Opening CalculatorOpening CalculatorOpening CalculatorOpening Calculator
1. Press the Home button . 

2. Select the Organizer category .

3. Select the Calculator icon .
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Using the Calculator buttonsUsing the Calculator buttonsUsing the Calculator buttonsUsing the Calculator buttons
Calculator includes several buttons to help you perform calculations.

• Clears the last number you entered. Use this button if you make a 
mistake while entering a number in the middle of a calculation. This 
button enables you to re-enter the number without starting the 
calculation over.

• Clears the entire calculation and enables you to begin a fresh 
calculation.

• Toggles the current number between a negative and positive 
value. If you want to enter a negative number, enter the number first 
and then press the +/- button.

• Places the current number in memory. Each new number you 
enter with the M+ button is added to the total stored in memory. The 
number that you add can be either a calculated value or entered by 
pressing the number buttons. Pressing this button has no effect on the 
current calculation (or series of calculations); it merely places the value 
into memory until it is recalled.

• Recalls the stored value from memory and inserts it in the current 
calculation.

• Clears any value stored in Calculator’s memory.
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Displaying recent Displaying recent Displaying recent Displaying recent ccccalculationsalculationsalculationsalculations
The Recent Calculations command lets you review the last series of 
calculations and helps you confirm a chain of calculations.

1. In Calculator, tap the Menu icon .

2. From the Options menu, select Recent Calculations.

3. After you finish reviewing the calculations, tap OK.
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Setting Setting Setting Setting PPPPreferencesreferencesreferencesreferences
The Preferences screens enable you to customize your console in a variety of 
ways. Your console includes the following Preferences screens:

• Bluetooth

• Calibration

• Connection

• Date & Time

• Formats

• General

• Graffiti 2

• Network

• Owner

• Phone

• Quick Launch

• ShortCuts

• Sound

Opening tOpening tOpening tOpening the Preferences screenhe Preferences screenhe Preferences screenhe Preferences screenssss
1. Press the Home button .

2. Select the Prefs category .

3. Select the Preferences screen you want to view.
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BluetoothBluetoothBluetoothBluetooth
The built-in Bluetooth radio enables you to play multiplayer games and 
exchange data with other devices enabled with Bluetooth technology. The 
Bluetooth Preferences settings control the built-in Bluetooth radio, and 
include the following:

• Radio. Turn the Bluetooth radio on and off. 

TIP:TIP:TIP:TIP: You can also turn the radio on or off by pressing and holding the Bluetooth 

button . 

• Device Name. Assign a name to your console for Bluetooth 
communication. By default the device name is the same as your 
HotSync user name.

• Discoverable. Indicate whether you want your console to be seen by 
other Bluetooth devices. You can accept or reject invitations from 
other devices. 

TIP:TIP:TIP:TIP: If you want to leave the Discoverable setting off, you can make your 
console temporarily discoverable (for three minutes) by quickly pressing 

and releasing the Bluetooth button . 

• Trusted Devices. Create a buddy list of Bluetooth devices from which 
your console should automatically accept communications. For each 
device you must enter an identical passkey on both devices. If a device 
without a recognized passkey attempts to communicate with your 
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console, it goes through the discovery and authentication process, and 
you can choose to accept or reject the communication.

For additional information about using the Bluetooth features of your console 
visit tapwave.com.

CCCCalibrationalibrationalibrationalibration
The Calibration Preferences screen enables you to calibrate your console so 
that it accurately interprets taps on the touch-screen and movements of the 
analog controller . If you tap an option on the screen and it activates a 
different option, or if you move the analog controller and the insertion point 
moves in the wrong direction, you need to calibrate. To calibrate the screen or 
analog controller, simply follow the onscreen instructions and tap the targets 
or move the analog controller as indicated.

ConnectionConnectionConnectionConnection
The Connection Preferences screen allows you to create configurations that 
enable your console to use a PC, modem, or GSM mobile phone to 
communicate with remote devices such as your ISP or a remote computer—
provided the appropriate hardware is available. The Connection Preferences 
screen displays a list of available configurations which is based on the 
software installed on your console. If necessary you can use the buttons at the 
bottom of the screen to add, modify, or delete configurations.

http://www.tapwave.com
http://www.tapwave.com
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When you create or modify Connection Preferences, you are presented with 
the following choices:

• Name. Assign or modify the configuration name. This is the label that 
appears in the list in the Connection Preferences screen.

• Connect to. Select the type of device to which you want to connect 
your console. The choices are: PC, Modem, Phone, and Local Network.

• Via. Select the method you are using to connect your console and the 
selected device. The choices are: Cradle/Cable, Infrared, and Bluetooth.

• Dialing (modem only). Indicate whether to use Touchtone or Rotary 
dialing tones. Select Rotary only if your telephone service does not 
support TouchTone dialing.

• Volume (modem only). Indicate how loud you want the dialing tones.
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• Model (phone only). Select the model of your phone. If your phone 
does not appear in the list, select Standard GSM, or install a phone 
driver.

• Details. Provides access to the following additional settings:

– Speed. Select the maximum speed for your modem to 
communicate with your console. This setting does not control the 
speed at which your modem communicates with your telephone 
service.

– Flow Ctl (Flow Control). Select a connection option. Options are 
Automatic, On (Xon), or Off (Xoff).

– Init String (modem and phone only). Enter or edit text to change 
the modem or phone setup string. 

Date & TimeDate & TimeDate & TimeDate & Time
The Date & Time Preferences screen is where you set the date, time, time zone, 
and Daylight Savings time for your console. These settings are used in all the 
applications on your console which respect the system calendar and clock.

The Date & Time Preferences screen includes the following settings:
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• Set Date. Set the system calendar by selecting the current date.

– Year. Tap the arrows at the top of the Set Date Screen to select the 
current year.

– Month. Tap the box for the current month.

– Date. Tap the number for the current date.

– Today. Tap this button to accept your date selection.

• Set Time. Set the system clock by selecting the current time.

– Hour. Tap the hour box and then tap the arrows to change the 
hour. 

– Minutes. Tap each minute number, and then tap the arrows to 
change the number. 

– AM/PM. Tap the boxes to choose the AM or PM suffix.

NOTE:NOTE:NOTE:NOTE: To display time based on a 24-hour clock, change the time format. 
See page 129.

• Set Time Zone. Select the time zone for the system clock. Choose the 
time zone from the list that corresponds to where you are. When you 
travel, use this dialog to change time zones. If you’re not sure what 
time zone you are in, find out what time it is, and select the time zone 
which shows the correct new time. 
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• Daylight Saving. Indicate whether Daylight Saving is currently 
applicable in your area.

FormatsFormatsFormatsFormats
The Formats Preferences screen enables you to choose a default country for 
your console and to set default formats for times, dates, and numbers. These 
formats apply to all the dates, times, and numbers in all the applications on 
your console. The Formats Preferences screen includes the following settings:

• Preset To. Select a country name. When you select a country, the other 
settings adjust as well. For example, if you select Germany, time is 
expressed using a 24-hour clock and the starting day of the week is 
Monday; if you select the United States, time is expressed using a 12-
hour clock with an AM or PM suffix and the starting day of the week is 
Sunday. You can, however, customize the individual settings regardless 
of which country you select. 
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• Time. Select a format. H is hour and M is minute.

• Date. Select a format. D is day, M is month, and Y is year.

• Week starts. Select Sunday or Monday as the first day of the week. 

• Numbers. Select the decimal point and thousands separator.

GeneralGeneralGeneralGeneral
The General Preferences screen enables you to adjust various settings in order 
to save battery power when your console is not connected to a power outlet, 
and to set the position of the Input Area. The General Preferences screen 
includes the following settings:

• Auto-off after. Set when your console automatically shuts off. After 
the selected period of inactivity, the power and backlight turn off to 
conserve battery power. If you find that your console shuts itself off 
before you finish reviewing the information on the screen, increase this 
setting. 

• Stay on in Cradle. Determine whether to keep your console on while it 
is connected to the HotSync cable or cradle and a power outlet. 
Choosing Off causes your console to shut off after the Auto-off interval 
(also set on this screen) expires. 

• Beam Receive. Indicate whether you want to prohibit anyone from 
beaming information to your console. If you disable beaming, it saves 
a little battery power. By default, Beam Receive is enabled.



Setting Preferences
Graffiti 2

Using Your Zodiac Console 131131131131

• Brightness. Adjust the brightness of the display by dragging the slider 
on the screen.

• Input Area Position. Indicate whether you want the Status Bar and 
Input Area to appear on the left or right side of the screen when the 
display is in landscape mode. This option is designed to facilitate left-
handed data entry.

TIP:TIP:TIP:TIP: Tap the Orientation icon  in the Status Bar to switch between portrait 
(horizontal) and landscape (vertical) mode.

In addition to the settings mentioned above, you can also choose a color 
theme for all your application screens:

1. Tap the Menu icon .

2. From the Extras menu, select System Color Theme. 

3. From the Colors pick list, select the color theme you want to use.

4. Tap Done.

Graffiti 2Graffiti 2Graffiti 2Graffiti 2
The Graffiti 2 Preferences provides alternate strokes for making the T, P, Y, and 
$ characters. For example, you may want to form the letter T by using strokes 
similar to a space and an L. But if this technique is difficult to control, you can 
turn off this option. You can set preferences by tapping the characters that 
appear on the following Graffiti 2 Preferences screen.
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NetworkNetworkNetworkNetwork
Network Preferences let you set a password, telephone number, DNS number, 
IP address, as well as create a login script for remote connections. You can use 
a preset service template for your ISP or dial-in server, and edit, save, and 
reuse settings. Or you can create your own service template.

To use the TCP/IP software included in the console operating system for 
remote connections, you must set Network Preferences, as well as Connection 
Preferences. 

The Network Preferences screen includes the following settings:

• Service. Select a predefined service template you want to use. If you 
use one of the predefined service templates, you probably only need 
to enter your user name and telephone number. If the service template 
you want does not appear on the list, you can create your own service 
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templates from scratch or duplicate existing templates and edit the 
information using the New and Duplicate commands on the Service 
menu.

• User Name. Enter the name you use when logging in to your ISP or 
dial-in server. Do not enter spaces unless your dial-in server accepts 
them.

• Password. Indicate whether to save your password as part of the 
template. 

– Prompt. If you’re concerned about security and want to be 
prompted for your password when logging in to your ISP or dial-up 
server, do not enter anything. Leave “Prompt” in the Password field. 

– Assigned. If you do not want to be prompted for a password 
during login, tap the Password field and enter your password. 
“Assigned” appears in the Password field.

• Connection. Select a configuration. The list includes the 
configurations displayed on the Connection Preferences screen.

• Phone. Enter the phone number you use to reach your ISP or dial-in 
server. When you tap the Phone field, you have the following 
additional options:

– Dial prefix. Indicate whether you need to enter a prefix before 
dialing the telephone number to access an outside line. For 
example, many offices require that you dial “9” to dial a number 
outside the building. If you need to use a prefix, check the Dial 
Prefix box, and enter the prefix. 

– Disable call waiting. Toggle call waiting on and off. Call Waiting 
can end your network session if you receive a call while you are 
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connected. To turn off Call Waiting, check the Disable call waiting 
box, and enter the code to turn off Call Waiting. If you don’t know 
the code, contact your local telephone company for the 
appropriate code. 

– Use calling card. Indicate whether you want to put the charges for 
the phone call on a calling card. To activate this option, check the 
Use Calling Card box, and then on the Use Calling Card line, enter 
three commas followed by your calling card number. Each comma 
delays transmission of your calling card number for two seconds, to 
compensate for the delay before the number is entered. 

NOTE:NOTE:NOTE:NOTE: MCI customers must enter the calling card number in the Phone # 
field, and the phone number in the Use Calling Card field.

Network DetailsNetwork DetailsNetwork DetailsNetwork Details
The Details dialog box enables you to select TCP/IP settings. When you tap the 
Details button, you have the following additional options:

• Connection type. Select the connection protocol you want to use for 
this service template:

– PPP for Point-to-Point protocol. Select this type if you’re unsure 
which you need. If PPP doesn’t work, ask your ISP or your system 
administrator for the correct connection type.

– SLIP. Select this type for Serial Line Internet protocol connections.

– CSLIP. Select this type for Compressed Serial Line Internet protocol 
connections.
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• Idle timeout. Specify how long your console waits to drop your 
connection when you exit a TCP/IP application. Options include 
Immediate, 1 minute, 2 minutes, 3 minutes, or Never (until the power is 
off or your console times out).

• Query DNS. Indicate whether a DNS number is required. The Internet 
uses the Domain Naming System (DNS) to translate the names of host 
computers into IP addresses. A DNS number (or IP address) identifies a 
specific server that handles the translation services. Anyone who logs 
onto the Internet must have a unique identifier—an IP address. This IP 
address can be either temporary—assigned automatically each time 
you log on—or permanent. Not all systems require that you enter a 
DNS number; check with your system administrator to see if it is 
required. 
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To enter a DNS number, uncheck the Query DNS box (the Primary and 
Secondary DNS fields appear). In the Primary DNS number field, tap 
the space to the left of the first period in the Primary DNS field and 
enter the first section of the IP address using a number only, from 0 to 
255; repeat the step for the remaining sections of the field. Use the 
same technique to enter the Secondary DNS number.

• IP Address Automatic. Indicate whether your server’s IP address is 
temporary or permanent. If your IP address is automatic and 
temporary, make sure that the IP Address box is checked. If your IP 
address is permanently assigned, uncheck the IP Address box. In the 
permanent IP address field, tap the space to the left of the first period, 
and enter the first section of the IP address using a number only, from 
0 to 255. Repeat the step for the remaining sections of the field.

LLLLogin scriptsogin scriptsogin scriptsogin scripts
A login script is a series of commands that automates logging into your ISP or 
remote server. 

You can create login script files by selecting commands in the Login Script 
dialog box. Some commands, such as Send, require additional information 
and have a parameter field to add the necessary data. 

You can also use non-ASCII and literal characters in your login script. See page 
138 for more information.

1. With a service template selected in the Network Preferences screen, tap 
Details.

2. In the Details dialog box, tap Script.
S
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3. From the End pick list on the Login Script screen, select any of the 
following commands and enter additional information if a field appears:

• Wait For. Instruct your console to wait for specific characters from the 
TCP/IP server before executing the next command.

• Wait For Prompt. Instruct your console to use a dynamically 
generated challenge-response value from the server. You must enter 
the challenge value into your token card. This generates a response 
value which you must enter on your console. This command requires 
two arguments that are separated by a vertical bar (|).

• Send. Transmit specific characters to the TCP/IP server to which you 
are connecting.

• Send CR. Transmit a carriage return or LF character to the TCP/IP 
server to which you are connecting.

• Send User ID. Transmit the User ID information entered in the User ID 
field of the Network Preferences screen.

• Send Password. Transmit the password entered in the Password field 
of the Network Preferences screen. If you did not enter a password, this 
command prompts you to enter one. The Password command is 
usually followed by a Send CR command.

• Delay. Instruct your console to wait a specific number of seconds 
before executing the next command in the login script.

• Get IP (for SLIP connections). Read an IP address and use it as the IP 
address for your console. 

• Prompt. Open a dialog box that prompts you to enter text of some 
kind (for example, a password or a security code).

• End. Identify the last line in the login script.

4. Repeat steps 2 and 3 to complete the login script.

5. Tap OK, and then tap OK in the Details dialog box.



Setting Preferences
Network

Using Your Zodiac Console 138138138138

Non-ASCII characters

If you know how to write custom scripts with non-ASCII characters, you can 
incorporate the caret (^char) character, carriage returns and line feeds, and 
literal characters in your custom login scripts.

• Use the caret (^ char) character to transmit ASCII command characters. 
If you send ^char, and the ASCII value of char is between @ and _, then 
the character is automatically translated to a single-byte value 
between 0 and 31. 

For example, ^M is converted to a carriage return. If char is a value 
between a and z, then the character sequence is translated to a single-
byte value between 1 and 26. If char is any other value, then the 
character sequence is not subject to any special processing. Thus, the 
string “Joe^M” transmits Joe, followed by a carriage return.

• You can include carriage return and line feed commands as part of the 
login script, when entered in the following format:

<cr>Sends or receives a carriage return

<lf>Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe, 
followed by a carriage return and line feed from the remote computer, 
before executing the next command in the script.

• You can use the backslash ( \ ) character to specify that the next 
character be transmitted as a literal character, and not be subject to 
any special processing ordinarily associated with that character. For 
example:

\^Includes a caret as part of the string

\<Includes a < as part of the string

\\Includes a backslash as part of the string
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Connecting to your ISP or dial-in serviceConnecting to your ISP or dial-in serviceConnecting to your ISP or dial-in serviceConnecting to your ISP or dial-in service
After you set Connection and Network Preferences, you can easily connect to 
your ISP or dial-in server. 

You can make the connection using either Network Preferences commands or 
a third-party application. Connecting to an ISP requires a third-party 
application, such as a Web browser or news reader. For information on third-
party applications that support TCP/IP, check the Web site tapwave.com.

1. From the Network Preferences screen, tap Connect to dial the current 
service and display the Service Connection Progress messages. 

2. To see expanded Service Connection Progress messages, press Down 
during login.

3. Tap Disconnect to terminate the connection between your console and 
your service.

OwnerOwnerOwnerOwner
Use Owner Preferences to record a name, company name, phone number, or 
any other identification information you want to include on your console.

If you use Security to turn off and lock your console with a password, the 
information that you enter in Owner Preferences appears the next time you 
turn on your console. 

NOTE:NOTE:NOTE:NOTE: If you assign a password to your console using Security, you must 
tap Unlock and enter your password to change the Owner Preferences screen. 

http://www.tapwave.com
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PhonePhonePhonePhone
Use the Phone Preferences screen to pick a connection profile. These settings 
are used by SMS and a variety of third-party applications.

• Connection. Select a Connection configuration for applications that 
require a phone connection. Base your selection on your hardware 
setup, such as Bluetooth or Infrared to a particular model phone. The 
details of your connection should already be set up, in the Connection 
Preferences. However, you can edit information from this pick list if 
necessary.

If no connection methods are available, then --None-- appears in the 
pick list. This means that no phone drivers exist on your console. In this 
case you must install the phone driver on your computer and 
synchronize with your console.

If your phone is enabled and connected, you can test the connection 
by tapping the Test button. This initiates a simple query of the phone 
to make sure the connection is working and the correct phone is being 
used.
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Quick LaunchQuick LaunchQuick LaunchQuick Launch
Use the Quick Launch Preferences screen to assign an application to each of 
the four Action buttons. When you hold down the Home button while 
pressing any of these buttons, the assigned application opens immediately.

TIP:TIP:TIP:TIP: The Quick Launch settings also apply to the one button Quick Launch from 
Home Screen option on the Home Preferences screen. See page 47 for details.

SSSShortCuhortCuhortCuhortCutttt
ShortCut Preferences enable you to create ShortCuts for up to 45 characters. 
For example, you could create a ShortCut for your name or for the header of a 
memo. All ShortCuts you create appear on the list in the ShortCut Preferences 
screen, are available in any of your console applications, and are backed up on 
your computer when you perform a HotSync operation.

The ShortCuts Preferences screen includes the following options:
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• New. Define a new shortcut.

– ShortCut Name. Enter the letters you want to use to activate the 
ShortCut.

– ShortCut Text. Enter the text that you want to appear when you 
write the ShortCut characters. 

TIP:TIP:TIP:TIP: You can add a space character after the last word in your ShortCut text 
so that a space automatically follows the ShortCut text.

• Edit. Modify an existing ShortCut. From the ShortCut Preferences 
screen, tap the ShortCut you want to edit, tap Edit, and then enter your 
changes.

• Delete. Remove a ShortCut. From the ShortCut Preferences screen, tap 
the ShortCut you want to delete and then tap Delete.
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SoundSoundSoundSound
The Sound Preferences enable you to adjust the sound and alarm settings 
using the following settings:

•  Turn all sounds on or mute all sounds. When sound is on, 
you have the following options:

– Application Volume. Adjust the volume level for the sounds in 
your applications by dragging the slider or tapping to the right 
or left of the slider to move it in small increments. Some older 
Palm OS® games may not respond to this setting.

– Headphone Bass. Set the bass level for sounds in your 
applications. The choices are: Normal or Boost.

– System Volume. Set the volume level for system sounds. The 
System Volume level is relative to the Application Volume level. As 
you increase or decrease the Application Volume level the System 
Volume level follows. Turning off the System Volume also turns off 
the chime tones during HotSync operations. The choices are: Off, 
Low, Medium, or High.

– Alarm Volume. Set the volume level for alarm sounds. The choices 
are: Off, Low, Medium, or High.

– Alarm Vibrate. Set the vibrate option to On, Off, or When Muted. 
When you enable the Alarm Vibrate setting, your console vibrates 
to notify you of alarms. This is useful when you want the Alarm 
Sound off, but still want to be notified of alarms. 

When sound is muted, you have the following options:

– Mute Until. Choose how long you want sounds to remain off. The 
choices vary based on the current time.
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SyncSyncSyncSynchronizing Datahronizing Datahronizing Datahronizing Data
HotSync technology lets you synchronize—exchange and update—data 
between your Zodiac console and Palm Desktop software or another desktop 
organizer application such as Microsoft Outlook. You synchronize your data 
by connecting your console to your computer with the HotSync cable or 
cradle.

The HotSync process automatically synchronizes data between your console 
and Palm Desktop software. Changes you make on your console or in Palm 
Desktop software appear in both places after a HotSync operation. HotSync 
technology synchronizes only the data that has changed since the last 
HotSync operation, thus reducing synchronization time. 

This chapter describes how to select HotSync options and perform a HotSync 
operation. 

PPPPerforming a cable or cradle erforming a cable or cradle erforming a cable or cradle erforming a cable or cradle HHHHotSync operationotSync operationotSync operationotSync operation
The following steps assume that you have already installed the Palm Desktop 
software. If you have not installed this software, see page 17 for instructions.

1. Connect your console to the HotSync cable or cradle.
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The bottom edge of the console should align smoothly with the cable or 
cradle when it is properly connected.

2. Make sure the HotSync Manager software is running.

If it is running, the HotSync icon ™ appears in the Windows system tray. 
If HotSync Manager is not running, click the Start button on the Windows 
desktop and choose Programs. Navigate to the Palm Desktop software 
program group and choose HotSync Manager. Alternatively, you can 
start the Palm Desktop software which automatically opens HotSync 
Manager.

3. Press the HotSync button on the cable or cradle.

HotSync button
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4. If prompted, select the user name you entered when you installed Palm 
Desktop software. The HotSync Progress dialog box appears and 
synchronization begins. 

Every console should have a unique name. To prevent loss of a user’s 
records, never try to synchronize more than one console to the same user 
name. If you need to create a new user name, see the Palm Desktop 
Online Help for instructions.

5. Wait for a message on your console indicating that the process is 
complete.

When the HotSync process is complete, you can remove your console from 
the HotSync cable or cradle.

Selecting Selecting Selecting Selecting HHHHotSync setup optionsotSync setup optionsotSync setup optionsotSync setup options
You can choose when you want HotSync Manager to run. If necessary, you can 
adjust the other HotSync settings as well.

1. Click the HotSync Manager icon  in the Windows system tray.

2. Choose Setup. 

3. Click the General tab, and select one of the following options:

• Always Available. Add HotSync Manager to the Startup folder and 
constantly monitor the communication port for synchronization 
requests from your console. With this option, HotSync Manager 
synchronizes data even when Palm Desktop software is not running.
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• Available Only When Palm Desktop software Is Running. Start 
HotSync Manager and monitor requests only when you open Palm 
Desktop software.

• Manual. Monitor requests only when you select HotSync Manager 
from the Start menu.

If you’re not sure which option to use, keep the default setting, Always 
Available.

4. Click OK.

Customizing Customizing Customizing Customizing HHHHotSync application settingsotSync application settingsotSync application settingsotSync application settings
For each application, you can define how records are handled during 
synchronization. These synchronization settings are called a “conduit.” By 
default, a HotSync operation synchronizes data for all the applications that are 
present on your console and in Palm Desktop software. 

In general, you should leave the settings to synchronize all files. The only 
reason you might want to change these settings is to overwrite data on either 
your console or Palm Desktop software, or to avoid synchronizing a particular 
type of file because you don’t use it.

In addition to the conduits for Date Book, Address Book, To Do List, Memo 
Pad, Photos, and Music, Palm Desktop software includes High Score, System, 
and Install conduits. The High Score conduit synchronizes the high score 
database with the Tournament Zone on the Tapwave web site. The System 
conduit backs up the system information stored on your console, including 
Graffiti 2 ShortCuts. The Install conduit installs applications on your console. 
You can install additional conduits for add-on applications that include 
desktop synchronization features.

1. Click the HotSync icon  in the Windows system tray (bottom-right 
corner of the taskbar).

TIP:TIP:TIP:TIP: You can also click the HotSync command on the Palm Desktop software 
menu bar.

2. From the HotSync Manager menu, choose Custom.
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3. Select the appropriate user name from the list.

4. Select an application in the Conduit list. Click Change.

5. Click the direction in which you want to write data, or click Do Nothing to 
skip data transfer for an application.

6. Choose how long the setting remains in effect:

• To affect only the next HotSync operation, deselect Set As Default. 
Thereafter, the HotSync Actions revert to their default settings. 

• To use a new setting as the default, select the Set As Default option. 
Thereafter, whatever you selected as the default setting is used when 
you click the Default button in the Custom dialog.

7. Click OK.

8. Repeat steps 4 - 7 to change conduit settings for other applications.

9. Click Done to activate your settings.
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SSSSecurityecurityecurityecurity
Your console includes a Security application that lets you set options to 
protect entries from unauthorized users in a variety of ways:

Security application lets you: 

• Mask or hide entries you have defined as private. The Mask option 
displays a gray bar over private records, and the Hide option 
completely removes (hides) private records. 

• Assign a password to viewing options to enhance security. Assigning a 
password requires you to enter a password before private entries can 
be viewed; not assigning a password lets you view private entries 
when you Show Records from the Security dialog box. 

• Lock and turn off your console so that a password must be entered 
before you can use your console again. 

• Hide records that you have defined as private, with or without a 
password. Without a password, private records are hidden until you set 
Security to display them; with a password, you must enter the 
password to view the private entries.
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Masking and hiMasking and hiMasking and hiMasking and hidddding recordsing recordsing recordsing records
You can mask or hide private records. When you mask private records, a visual 
placeholder appears where the record would normally be displayed; when 
you hide records, they are not visible anywhere in the list. 

Masking private recordsMasking private recordsMasking private recordsMasking private records
1. Make sure that the record or records you want to mask are defined as 

private. To make a record private, select the record, tap Edit, tap Details, 
and then check the Private box. 

2. Press the Home button . 

3. Select the Utilities category .

4. Select Security .

5. From the Current Privacy pick list, select Mask Records. 

6. Open one of the Organizer applications and view a record. Records 
marked as private are masked with a gray bar. 

Hiding private recordsHiding private recordsHiding private recordsHiding private records
1. Make sure that the record or records you want to hide are defined as 

private. To make a record private, select the record, tap Edit, tap Details, 
and then check the Private box. 

2. Press the Home button . 

3. Select the Utilities category .
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4. Select Security .

5. From the Current Privacy pick list, select Hide Records.

6. When you return to the Organizer applications, records marked as private 
are not included in the display.

Note that you can mask or hide records without assigning a password, or you 
can assign a password if you want records to remain masked or hidden until a 
password is entered. 

Assigning and editing Assigning and editing Assigning and editing Assigning and editing ppppasswordsasswordsasswordsasswords
You can assign a password to protect your private records and to lock your 
console.

Once you define a password, you can change or delete it at any time. You 
must enter the current password before you can change or delete it. 

If you’ve forgotten your password, you can delete it, see page 153.

1. Press the Home button . 

2. Select the Utilities category .

3. Select Security .

4. Tap the Password box. 
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5. Enter a password—either the one you want to assign or your current 
password if you want to change or delete it—and tap OK.

6. Choose from the following options:

• To assign a password, enter the password again to verify it, and tap OK. 

• To change your password, enter a new password and tap OK.

• To delete your password, enter your current password. Tap OK, and 
then tap Unassign.

LLLLocking your consoleocking your consoleocking your consoleocking your console
You can turn off and lock your console with a password to protect 
information. You must then enter the password when you turn on your 
console to gain access to the information on it. 

If you forget the password, you must perform a hard reset to resume using 
your console. Performing a hard reset deletes all the records in your console; 
however, you can restore all synchronized data at the next HotSync operation. 
See page 180 for more information. 

1. Assign a password, as described on page 151. 

A password is required before using the Turn Off & Lock option.

2. Tap Lock & Turn Off. The System Lockout dialog box appears. 
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3. Tap Off & Lock. Your console turns off and locks. 

Turning on and unlocking your consoleTurning on and unlocking your consoleTurning on and unlocking your consoleTurning on and unlocking your console
1. Turn on your console. 

2. Enter your password at the prompt, and then tap OK. 

Recovering from a forgotten Recovering from a forgotten Recovering from a forgotten Recovering from a forgotten ppppasswordasswordasswordassword
If the Off & Lock option is not active, and you forget your password, you can 
delete the forgotten password from your console. Deleting a forgotten 
password also deletes all entries and files marked as Private.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: If you synchronize with your computer before deleting a 
forgotten password, your console restores private entries the next time you 
perform a HotSync operation, but does not restore the forgotten password. 

Deleting a forgotten passwordDeleting a forgotten passwordDeleting a forgotten passwordDeleting a forgotten password
1. Press the Home button . 

2. Select the Utilities category .

3. Select Security .

4. Tap the password box.

5. Tap Lost Password.

6. A message appears; tap Yes to delete the forgotten password. 
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Using the AUsing the AUsing the AUsing the Atttttention Managertention Managertention Managertention Manager
Many applications (such as Date Book and Clock) want to get your attention 
with some sort of alarm. Attention Manager provides a way for you to 
conveniently manage all of these notifications in one place. Appointments 
and messages can stack up while you are away from your console. You can 
then use Attention Manager to view them from a single list and selectively 
dismiss or follow up on each alarm.

Alarms request your attention at two different levels: insistent and subtle. This 
chapter describes both types of requests.

InsisteInsisteInsisteInsistennnnt alt alt alt alaaaarmsrmsrmsrms
Insistent applications open a Reminder screen, and may play a sound, flash an 
LED, or vibrate, depending on your hardware configuration. Alarms continue 
until you snooze or dismiss them. If the sound can be interrupted, you can tap 
anywhere on the screen, or press any button to silence it. Attention Manager 
opens immediately when new insistent alarms are posted.

UUUUsing the Remsing the Remsing the Remsing the Remiiiinder nder nder nder sssscreencreencreencreen
The Reminder screen has three buttons for responding to an alarm:

• OK. Makes the reminder go away, with no further notification.
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• Snooze. Switches to the application that was running when the alarm 
went off, and returns to the Reminder screen after five minutes. You 
can go back to the Reminder screen right away by tapping the blinking 
indicator in the Status Bar. For more information on the blinking 
indicator, see page 157. 

• Go To: Switches to the application that created the alarm, and shows 
the record that caused the alarm, although you may have to navigate 
within the application. There is no further notification.

Setting alarSetting alarSetting alarSetting alarmmmm sound effects sound effects sound effects sound effects
Some applications allow you to set the tune or sound effect to use, and how 
many times to play it, with a pause in between. For example, to set alarm 
preferences for Date Book, do the following:

1. In Date Book, tap the Menu icon .

2. From the Options menu, select Preferences.

3. Check the Alarm Preset box, if you want alarms to sound, then select the 
following from the pick lists:

• Alarm Preset. Indicate how soon you want the alarm to sound before 
the event.

• Alarm Sound. Choose the alarm tune or sound effect (for example, 
Bird or Concerto).

• Remind Me. Specify how many times the alarm repeats before it stops.

• Play Every. Set the pause between each time the alarm sounds.

For information on setting the alarm volume level and vibrate option, see 
page 143.
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Using the Reminders list screenUsing the Reminders list screenUsing the Reminders list screenUsing the Reminders list screen
The Reminder screen changes to a Reminders list under two insistent alarm 
conditions:

• When a second application attempts to get your attention and the first 
has not been dismissed or snoozed.

• When a first application makes a second attempt and the first has not 
been dismissed or snoozed.

Each reminder lists the date and time of the alarm. Depending on the 
application displaying the reminder, you may see an icon representing the 
application, and up to two lines of text. 

Tapping the text or icon jumps to that item and deletes the event from the 
Reminders list screen.

Checking a box clears that item, similar to a To Do list item. The Attention 
Manager draws a line through the text lines, pauses for a moment, and then 
removes the item from the list, although the original data remains in the 
application.

The Reminders list screen displays three buttons that you can use to respond 
to the items in the list:

• Done. If the Reminders list appeared because of more than one 
insistent alarm, tapping Done closes the Reminders list screen, 
although the events remain in the application that created them. The 
Reminders list screen does not appear again, unless you tap the 
blinking alarm indicator in the Status Bar.
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If the Reminders list appeared after you tapped the Snooze button, 
then tapped the blinking alarm indicator, then tapped the Done 
button, the reminder continues to snooze.

For more detail, see the next section.

• Snooze. Put the Reminders list screen to sleep for five minutes. After 
this time interval, the Reminders list screen appears again. You can go 
directly to the Reminders list screen without waiting, by tapping the 
blinking alarm indicator. For more detail about the blinking indicator, 
see page 157.

• Clear All. Remove all of the items from the list and close the Reminders 
list screen. Tap this button to erase a list of events that have passed. 

SubtlSubtlSubtlSubtleeee alarms alarms alarms alarms
Some applications provide a visual, and optionally audible indication, but do 
not otherwise disrupt your work flow. Subtle alarms do not display a 
Reminder screen. Instead, a blinking indicator flashes (in applications that 
support it) when an alarm is present. 

Understanding the blinking alarm indicatorUnderstanding the blinking alarm indicatorUnderstanding the blinking alarm indicatorUnderstanding the blinking alarm indicator
In applications that allow it, a blinking alarm indicator appears in the Status 
Bar under the following conditions:

• While viewing a Reminder screen or Reminders list screen, you tap the 
Done or the Snooze button.

• A subtle alarm is present.

The indicator appears in two different states:

• Off. The indicator is not shown at all when the list is empty.

• Blinking. When there is an item in the list, then the “exclamation 
point” indicator blinks on and off until you empty the list.

Tapping the indicator opens the Attention Manager in list mode, even if there 
is only one item.
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Using Expansion CarUsing Expansion CarUsing Expansion CarUsing Expansion Carddddssss
Zodiac lets you add expansion cards to your console. Use expansion cards to: 

• Expand your console’s storage capacity

• Share files with other people

• Backup your data

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: On your console, expansion slot 1 (left) is compatible with 
Secure Digital (SD) and MultiMedia (MMC) expansion cards. Expansion slot 2 
(right) also supports SDIO expansion cards. Remember to use slot 2 for 
SDIO cards.

Slot 1 for 
SD and 
MMC 
cards

Slot 2 for 
SDIO, SD, 
and MMC 
cards
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Inserting and removing an expansion cardInserting and removing an expansion cardInserting and removing an expansion cardInserting and removing an expansion card
1. Hold the expansion card with the label facing you and the notch in the 

lower-left corner. 

2. Hold your console with the screen facing you.

3. Slide the expansion card into the slot until you feel it click into place.

4. When you’re done using the card, gently press the top of the card to 
release it from the slot and lift it out of the slot.

Accessing applications on an expansion cardAccessing applications on an expansion cardAccessing applications on an expansion cardAccessing applications on an expansion card
When an expansion card is inserted, the card automatically appears as a new 
Home category. This category is assigned the name of the expansion card 
volume; for example, the name “Card 1” is used throughout this section.

1. Insert an expansion card into an expansion slot.

NOTE:NOTE:NOTE:NOTE: If the Home screen does not appear, press the Home button  
and select the card name, such as Card 1.

Notch
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The applications on the card appear on the Home screen. 

2. Select the application that you want to launch.

The selected application is loaded into memory and launched. 

Displaying information about appDisplaying information about appDisplaying information about appDisplaying information about appllllications on an expansion cardications on an expansion cardications on an expansion cardications on an expansion card    
1. Insert an expansion card into an expansion slot.

2. Press the Home button .

3. Select the card name, such as Card 1.

4. Tap the card name in the title bar to open the menus. 

5. From the App menu, select Info.

6. From the Device pick list, select the card name. The screen displays the 
size of the applications on the card.
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7. To display the application version, tap Version.

TIP:TIP:TIP:TIP: When you tap More, you access the CardInfo application, described 
in the section that begins on page 164.

Copying an Copying an Copying an Copying an application from an expansion cardapplication from an expansion cardapplication from an expansion cardapplication from an expansion card
You can copy applications from an expansion card to any of the following:

• Another expansion cards

• Your console

• Your desktop software

1. Insert an expansion card into an expansion slot.

2. Press the Home button .

3. Select the card name, such as Card 1.

4. Tap the card name in the title bar to open the menus. 

5. From the App menu, select Copy.
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6. From the Copy From and To pick lists, select the source and the 
destination.

7. Select the application and then tap Copy.

The application is copied to the selected destination.

TIP:TIP:TIP:TIP: Some applications and databases are copy-protected and cannot be 
copied. These are listed with a lock icon next to them.

BBBBeaming or sending applications from an expansion cardeaming or sending applications from an expansion cardeaming or sending applications from an expansion cardeaming or sending applications from an expansion card
1. Insert an expansion card into an expansion slot.

2. Press the Home button .

3. Select the card name, such as Card 1.

4. Tap the card name in the title bar to open the menus. 

5. From the App menu, select Beam or select Send.
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6. From the Beam From (or Send From) pick list, select the card name.

7. Select the application you want to beam or send.

8. Make sure that the receiving device has infrared communication enabled 
for beaming, or Bluetooth communication enabled for sending.

9. Tap Beam or tap Send.

The application is beamed or sent to the other device. 

TIP:TIP:TIP:TIP: Some applications and databases are copy-protected and cannot 
be beamed. These appear with a lock icon next to them.

Deleting Deleting Deleting Deleting apapapapplications plications plications plications from an expansion cardfrom an expansion cardfrom an expansion cardfrom an expansion card
1. Insert an expansion card into an expansion slot.

2. Press the Home button .

3. Select the card name, such as Card 1.

4. Tap your user name in the title bar to open the menus. 

5. From the App menu, select Delete.
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6. From the Delete From pick list, select the card name, such as Card 1.

7. Highlight the application you want to delete, then tap Done.

The application is deleted. Applications that are loaded in ROM (for example, 
Memo Pad) cannot be deleted, and are not listed.

Using CardInfoUsing CardInfoUsing CardInfoUsing CardInfo
The CardInfo application displays summary information for each known 
directory type found on an expansion card. 

1. Insert an expansion card into an expansion slot.

2. If the Home screen does not appear, press the Home button .

3. Select the Utilities category .

4. Select the CardInfo icon .

5. From the Card pick list, select the card name, such as Card 1.

The CardInfo screen displays information about the expansion card seated in 
the expansion slot.
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Renaming an expansion cardRenaming an expansion cardRenaming an expansion cardRenaming an expansion card
1. Open Card Info.

2. Tap the Menu icon .

3. From the Card menu, select Rename Card. 

4. Enter the new name in the Rename Card dialog box.

5. Tap Rename.

RRRReformatting an expansion card eformatting an expansion card eformatting an expansion card eformatting an expansion card 
1. Open Card Info.

2. Tap the Menu icon .

3. From the Card menu, select Format Card. 
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4. Tap OK.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: Reformatting an expansion card erases all of its data.
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Beaming and Sending Beaming and Sending Beaming and Sending Beaming and Sending 
InformationInformationInformationInformation
Your Zodiac console is equipped with an IR (infrared) port that you can use to 
beam information to another Palm OS device that’s close by and also has an IR 
port. The IR port is located at the top of the console, behind the small dark 
shield. 

Your console is also equipped with a Bluetooth radio. If you are within range 
of other devices that are enabled with Bluetooth technology, you can use 
Bluetooth communication to send them information. The Bluetooth button 

 is located on the top of your console.

Additionally, if you install the optional SMS software from the CD that came 
with your console and you have a compatible mobile phone, you can use SMS 
technology to send information as well.

You can beam or send the following information between Palm Powered 
consoles and other compatible devices:

• The record currently displayed in Photos, Date Book, Address Book, To 
Do List, or Memo Pad.

• All records of the category currently displayed in the Photos, Address 
Book, To Do List, or Memo Pad applications.

• A special Address Book record that you designate as your business 
card, containing information you want to exchange with business 
contacts.

• An application installed in your console’s internal memory or on an 
expansion card seated in one of expansion slots.

NOTE:NOTE:NOTE:NOTE: To prevent music piracy, you cannot beam or send songs from the 
Music application.
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For best results while beaming, Zodiac consoles should be within one foot of 
each other, and the path between the two consoles must be clear of 
obstacles. Beaming distance to other Palm OS devices may be different.

TIP:TIP:TIP:TIP: You can also perform HotSync operations using the IR port. See page 171 
for more information.

Creating a Creating a Creating a Creating a bbbbusiness cardusiness cardusiness cardusiness card
1. In the Address List, create a new entry or select an entry that contains the 

information you want on your business card. See page 86 for more 
information.

2. In Address view, tap the Menu icon .

3. From the Record menu, select Select Business Card. 

4. At the prompt, tap Yes.

Beaming a Beaming a Beaming a Beaming a rrrrecordecordecordecord
1. Locate the record, business card, or category you want to beam.

2. Tap the Menu icon .

3. Make sure that the receiving device has infrared communication enabled.

4. From the Record menu, select the appropriate command:

• Beam. Beams an individual item.

• Beam Business Card. Beams the record defined as your business card. 
In Address Book only.

• Beam Category. Beams all records assigned to the selected category.

TIP:TIP:TIP:TIP: You can use the Graffiti 2 Command stroke /B to beam the current entry.

5. When the Beam Status dialog box appears, point the IR port directly at 
the IR port of the receiving console.

When the Beam Status dialog box indicates that the transfer is complete, 
you can resume working on your console.
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Beaming an Beaming an Beaming an Beaming an aaaapplicationpplicationpplicationpplication
1. Press the Home button .

2. Tap the left side of the title bar to access the menus.

3. From the App menu, select Beam.

4. Make sure that the receiving device has infrared communication enabled.

5. Select the application you want to transfer, and tap Beam.

NOTE:NOTE:NOTE:NOTE: Some applications are copy-protected and cannot be beamed, as 
indicated by a lock icon. 

6. When the Beam Status dialog box appears, point the IR port directly at 
the IR port of the receiving console.

When the Beam Status dialog box indicates that the transfer is complete, 
you can resume working on your console.

Receiving Receiving Receiving Receiving bbbbeamed informationeamed informationeamed informationeamed information
To receive beamed information the Beam Receive option in General 
Preferences must be turned on. See page 130 for details.

1. Turn on your console.

2. Point the IR port directly at the IR port of the transmitting console to open 
the Beam Status dialog box.
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3. Tap Yes.

4. Wait for the Beam Status dialog box to indicate that the transfer is 
complete, and then tap OK to display the new entry. 

5. Incoming records are placed in the Unfiled category.

Sending information with Sending information with Sending information with Sending information with BBBBluetooth communicationluetooth communicationluetooth communicationluetooth communication
1. If the Bluetooth radio is off, press and hold the Bluetooth button  to 

turn it on. The blue LED turns on or flashes when the radio is on.

2. Display the desired Date Book, Address Book, To Do List, or Memo Pad 
record you want to send.

3. Make sure that the receiving device has Bluetooth communication 
enabled.

4. Tap the Menu icon . 

5. From the Record menu, select the Send command. The command names 
vary based on the application (Event, Address, Category, Item, etc.).

6. Wait for the Discovery Results screen to appear.
 

7. Select the recipient’s user name from the list. If the name does not appear 
in the list, and the device is within range, tap Find More.

TIP:TIP:TIP:TIP: To choose which names appear in the list, tap the Show pick list and select 
Current Discovery to see only newly discovered devices, or Trusted Devices to see 
only devices that have a matching Bluetooth key.

8. Tap OK.
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IR HotSync operationsIR HotSync operationsIR HotSync operationsIR HotSync operations
You can use the IR port on your console to perform HotSync operations 
without a HotSync cable or cradle. This is very useful if you travel with an 
infrared-enabled laptop. You simply enable infrared communication on your 
laptop and console, and then follow the steps on page 172.

Preparing your computer for infrared communicationPreparing your computer for infrared communicationPreparing your computer for infrared communicationPreparing your computer for infrared communication
Not all computers are equipped to perform IR HotSync operations. The 
computer you want to synchronize with must meet the following 
requirements:

• The computer must support the IrCOMM implementation of the IrDA 
standards.

• The computer must have an installed infrared driver.

• The computer must have an enabled infrared port built-in, or an 
enabled infrared device attached to the computer. Desktop computers 
are likely to require an infrared device attached to a physical serial 
port. Laptops are likely to have a built-in IR port. 

If the infrared port on your computer is not enabled, see the documentation 
that came with your computer for instructions on enabling the infrared port.
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Configuring HotSync Manager for infrared communicationConfiguring HotSync Manager for infrared communicationConfiguring HotSync Manager for infrared communicationConfiguring HotSync Manager for infrared communication
Next you need to go to HotSync Manager and specify the infrared port that 
should be used for the HotSync operation.

1. Click the HotSync Manager icon in the Windows system tray.

2. Make sure Local is checked on the menu.

3. Choose Setup.

4. Click the Local tab.

5. In the Serial Port drop-down box, select the COM port or simulated port 
for your infrared port or device.

6. Click OK.

Performing an IR HotSync operationPerforming an IR HotSync operationPerforming an IR HotSync operationPerforming an IR HotSync operation
After you complete the steps to prepare for an IR HotSync operation it is easy 
to perform the actual operation.

1. Press the Home button .

2. Select the Utilities category .

3. Select the HotSync icon .

4. Tap Local.

5. From the pick list below the HotSync icon, select IR to a PC/Handheld.



Beaming and Sending Information
IR HotSync operations

Using Your Zodiac Console 173173173173

6. Position the IR port of your console within a couple of inches of the 
infrared port of your computer.

7. Tap the HotSync icon to start the IR HotSync operation.

Returning to cable or cradle HotSync operationsReturning to cable or cradle HotSync operationsReturning to cable or cradle HotSync operationsReturning to cable or cradle HotSync operations
It’s easy to return to using the cable or cradle for HotSync operations.

The next time you want to perform a HotSync operation just press the 
HotSync button on the cable or cradle. You can leave the HotSync application 
on your console set to perform IR HotSync operations and still use the cable or 
cradle. This is useful if you perform HotSync operations with both your 
desktop computer and a laptop that you travel with. When you travel you 
don’t have to carry a cable or cradle. When you are in the office just connect 
your console to the cable or cradle and press the HotSync button.

HotSync icon
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Maintaining Your ConsoleMaintaining Your ConsoleMaintaining Your ConsoleMaintaining Your Console

Migration iMigration iMigration iMigration informationnformationnformationnformation
You can replace your previous Palm OS device and migrate to a Zodiac 
console and retain your previous data and applications. If you already own a 
Palm OS device, Tapwave recommends that you install your new Zodiac 
desktop software into the same folder as your current Palm Desktop software. 
All of your data is preserved when you install the new software in the same 
folder as the previous software. If you use another desktop organizer 
application, such as Microsoft Outlook, you still must install the Zodiac 
desktop software CD that came with your new console.

You can perform HotSync operations on your new console in exactly the same 
way as you did on your old device, allowing you to quickly synchronize your 
existing data with your new console. Just remember to synchronize your old 
device with Palm Desktop software before you synchronize with your new 
console, so you have the latest information. When you synchronize your new 
console for the first time, select the Desktop Overwrites Handheld option for 
all the conduits. For more information on conduit settings, see page 147.

NOTE:NOTE:NOTE:NOTE: If you used security features (for example, password protection) on 
your previous Palm OS device, you must migrate to the most current desktop. 
The method of storing passwords has changed with the latest release of the 
desktop. Therefore, you must migrate to synchronize your password-protected 
information.

1. Synchronize your old device with your old Palm Desktop software to 
ensure that the latest information from your device is on your desktop 
computer.

2. (Optional) To prevent data loss, go to the folder that stores Palm Desktop 
software, copy the folder and its contents, rename it (for example, Palm 
Backup), and store the copy outside the Palm Desktop software folder.
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3. Follow the instructions on page 14 to install the Zodiac desktop software. 
Make sure you install the Zodiac desktop software in the same folder as 
the old desktop software.

4. To prepare for the first HotSync operation with your new console and 
new Zodiac desktop software, go to HotSync Manager and choose 
Custom.

NOTE:NOTE:NOTE:NOTE: Select your user name, if it does not already appear in the box.

5. For all conduits, click Change, and select the Desktop Overwrites 
Handheld option. Then click Done. See page 147 for more information.

6. Connect your new console to the cable or cradle and press the HotSync 
button. When the Select User dialog box appears, select your user name.

NOTE:NOTE:NOTE:NOTE: If you customized the modem setup on your old device, you must 
re-enter the modem initialization string. Any passwords you select on your old 
device are not restored during this HotSync operation. Records you previously 
marked Private remain marked Private, but you need to reenter a password on 
your new console.

7. If prompted to do so, perform a soft reset after completing the migration 
process (see page 179).

Some of your applications may appear in different categories from your old 
device. See page 45 for information on moving applications between 
categories.

IMPORTANT:IMPORTANT:IMPORTANT:IMPORTANT: After you complete the migration process, you have two devices 
with the same name. However, to prevent complications and unexpected results 
during HotSync operations, each device must have a unique name. 

8. Perform a hard reset on your old device. See page 180 for details. 

9. Perform a HotSync operation with your old device and give it a new user 
name.
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Creating a user profileCreating a user profileCreating a user profileCreating a user profile
You can create a user profile to load data into an console without associating 
that data with a user name. This feature lets System Administrators configure 
several consoles with specific information (such as a company phone list) 
before distributing them to their actual users. 

The User Profile feature is designed only for the first-time HotSync operation, 
before you assign a User ID to a particular console. 

1. Open Palm Desktop software.

2. From the Tools menu, choose Users.

3. Click Profiles. 

4. Click New. Enter a unique name for the profile and click OK. 

5. Click OK to return to Palm Desktop software. 

6. Select the profile from the User list and create the data for the profile (for 
example, company phone list, and so on).
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Using a profile for the first-time HotSync operationUsing a profile for the first-time HotSync operationUsing a profile for the first-time HotSync operationUsing a profile for the first-time HotSync operation
1. Connect your new console to the HotSync cable or cradle.

2. Press the HotSync button on the cable or cradle.

3. Click Profiles.

4. Select the profile that you want to load on the console, and click OK.

5. Click Yes to transfer all the profile data to the console.

The next time you perform a HotSync operation, Palm Desktop software 
prompts you to assign a user name to the console.

CCCCaring for your Zodiacaring for your Zodiacaring for your Zodiacaring for your Zodiac
Your Zodiac is a delicate portable electronic device and it should be handled 
with the same care you give to other delicate devices such as a digital camera, 
cell phone, etc. Please observe the following recommendations:

• If your console’s case gets a little soiled, clean it with a damp cloth. Do 
not wash or submerge your console in any liquid.

• Do not subject your console to unnecessary environmental stresses, 
including:

– Dropping your console

– Stepping on your console

– Sitting on your console

– Getting your console wet

– Using your console in sand storms

– Operating your console in extremely cold or hot temperatures

• As with any other electronic device, try not to subject your console to 
unnecessary static electricity. Static electricity in any electronic device 
can prematurely destroy that device. Your console is designed to 
tolerate a given amount of static electricity. Here are some suggestions 
to minimize damage from static electricity:

– Before you pick up your console, discharge yourself of static 
charges by touching any large surface (preferably metal).

– If you are using the optional cradle, discharge yourself of static 
charges by touching any large surface (preferably metal) prior to 
placing your console in the cradle. This is especially important in 
very dry environments where static charges can easily accumulate.
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TroubleshootingTroubleshootingTroubleshootingTroubleshooting
For additional troubleshooting information and answers to other frequently 
asked questions, visit http://support.tapwave.com.

I’m having trouble inI’m having trouble inI’m having trouble inI’m having trouble installing add-on softwarestalling add-on softwarestalling add-on softwarestalling add-on software....
Make sure the file you are trying to install is not a compressed file, such as a 
ZIP or SIT file. If the application is compressed, you must decompress the file 
before installing it.

IIII’m’m’m’m trying to run a game I just installed and I get an  trying to run a game I just installed and I get an  trying to run a game I just installed and I get an  trying to run a game I just installed and I get an 
“Authentication Error.” What does this mean?“Authentication Error.” What does this mean?“Authentication Error.” What does this mean?“Authentication Error.” What does this mean?

The games on the Tapwave.com store are locked or signed to a specific Zodiac 
serial number. An Authentication Error tells you that the game did not find the 
serial number it expected. If you get an authentication error here are a few 
things to check:

1. Verify that your Zodiac is registered and that the serial number on your 
console matches the number on the registration website. 

a. Press the Home button .

b. Tap your user name in the title bar to open the menus.

c. From the App menu, select Info

d. Tap Version at the bottom of the Info screen. 

e. Check the device ID number (Serial Number) at the top of the screen.

2. Check the folder(s) where you downloaded the game. Look for a TXT file 
with details on installing that particular game. Some games require an 
Installer application for the game to install and work properly. Delete the 
game and follow the instructions in the TXT file.

3. Make sure the file you are trying to install is not a compressed file, such as 
a ZIP or SIT file. If the application is compressed, you must decompress 
the file before installing it. Right click the ZIP file, extract all files, and 
then run the INSTALLER.EXE file.

http://support.tapwave.com
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My Zodiac won’t turn on.My Zodiac won’t turn on.My Zodiac won’t turn on.My Zodiac won’t turn on.
Zodiac has a data protection mode which activates if the battery level gets 
too low. Plug in the power adapter and let your Zodiac sit for about 5 minutes. 
With the charger still plugged in, press the Power button to make sure your 
Zodiac turns on. Let the Zodiac continue to fully charge for 2 hours.

My console is not responding.My console is not responding.My console is not responding.My console is not responding.
You may have to perform a reset if your console no longer responds to the 
buttons on the screen.

A soft reset allows your console to get a fresh start, similar to rebooting a PC. 
All records and entries are retained after a soft reset.

To perform a soft reset, use the tip of your stylus (or another object without a 
sharp tip such as an unfolded paper clip) to lightly press the reset button 
inside the hole on the back panel of your console.

I did a soft reset and my console is still not responding.I did a soft reset and my console is still not responding.I did a soft reset and my console is still not responding.I did a soft reset and my console is still not responding.
If you already performed a soft reset and you console is still not responding, 
or if you received an error while performing a soft reset, you may have to 
perform an extensions-off reset.

Reset 
button
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An extensions-off reset starts your console without adding anything extra to 
the operating system. This is similar to rebooting a PC in safe mode. All 
records and entries are retained after an extensions-off reset.

An extensions-off reset is extremely useful if your console stops responding 
after installing an add-on application. You can use an extensions-off reset to 
start you console and then uninstall the offending application. 

1. Hold down the Function button on the front of your console.

2. While holding down the Function button, use the tip of your stylus to 
gently press and release the reset button.

3. When the Palm logo appears, release the Function button.

4. Delete any possibly offending applications.

5. Perform a soft reset and confirm that your console is working properly.

6. Reinstall the applications you removed one at a time until you identify 
the offending application, and then contact the application’s developer 
to report the problem.

7. Repeat steps 1 – 4 to delete the offending application.

8. After you remove the offending application, perform a soft reset before 
you continue using your console.

I did I did I did I did an extensions-off ran extensions-off ran extensions-off ran extensions-off reset and console is still not responding.eset and console is still not responding.eset and console is still not responding.eset and console is still not responding.
If you already performed an extensions-off reset and you console is still not 
responding, or if you received an error while performing an extensions-off 
reset, you may have to perform a hard reset.

A hard reset erases all records and entries stored in your console. Never 
perform a hard reset unless a soft or an extensions-off reset does not correct 
your problem. When you perform your next HotSync operation, you can 
restore any data that you previously synchronized to your computer. To 
perform a hard reset, do the following:

1. Hold down the Power button  on the front of your console.

2. While holding down the Power button , use the tip of your stylus to 
gently press and release the reset button.

3. When the Palm logo appears, release the Power button.
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4. When a message appears on the console screen warning that all data 
stored on the console is about to be erased, do one of the following:

• Complete the hard reset by pressing the Function button on the front 
panel of the console. The Digitizer screen appears.

• Cancel the hard reset by press the Home button , and perform a 
soft reset instead.

NOTE:NOTE:NOTE:NOTE: When you perform a hard reset, the current date and time are 
retained. Formats, Preferences, and other settings are restored to their 
factory default settings.

When I tap an area on my screen, something else gets When I tap an area on my screen, something else gets When I tap an area on my screen, something else gets When I tap an area on my screen, something else gets 
highlighted or I have to tap above or below my target.highlighted or I have to tap above or below my target.highlighted or I have to tap above or below my target.highlighted or I have to tap above or below my target.

If this happens, the console screen needs to be realigned: 

1. Press the Home button .

2. Select the Prefs category .

3. Select Calibration.

4. Tap Touch Screen and follow the onscreen instructions.

IIII’m’m’m’m having trouble synchronizing with my computer.  having trouble synchronizing with my computer.  having trouble synchronizing with my computer.  having trouble synchronizing with my computer. 
If you’re having problems performing a HotSync operation, the following may 
help you:

1. Check the README file on your Zodiac desktop software CD. It includes 
information on HotSync operations and other topics, including tips, 
recent important changes, and any known incompatibilities between 
your Zodiac and other hardware and software.

2. Make sure you installed the Zodiac desktop software CD. If not, follow the 
instructions in the Quick Start Guide to install the software.

3. Make sure the HotSync icon ™ appears in the Windows system tray. If 
not, click the Windows Start button, select All Programs, choose Palm 
Desktop, and open HotSync Manager.
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4. Perform a HotSync operation. (Connect your console to your computer 
and press the HotSync button.) 

Did it work? If yes, the problem is fixed! If not, please continue and try a 
HotSync operation after each of the following steps until the problem is 
fixed.

5. Click the HotSync Manager icon in the Windows system tray. Verify that 
Local USB is checked. If not, click it.

6. Check the USB cable connections. Try another USB port. If the USB cable is 
plugged into a port on the front of your computer, plug your cable into a 
USB port on the back of your computer. Our testing revealed that back 
USB ports are more reliable than front USB ports.

7. Eliminate any USB conflicts. Disconnect any other USB devices, including 
hubs, and make sure that the cable is still firmly connected to the USB 
port on the back of the computer. It is best if the Zodiac cable is 
connected directly to your computer’s USB port.

If everything listed above fails, the problem may be a bad HotSync Cable. If 
you have access to another Zodiac HotSync cable, try it. If not, please contact 
our Customer Service department for additional assistance. 

When playing a game, the graphics are slow and choppy. When playing a game, the graphics are slow and choppy. When playing a game, the graphics are slow and choppy. When playing a game, the graphics are slow and choppy. 
There are a few features that can affect the performance of some games. If the 
graphics on your game are not running smoothly, check these things:

1. If the Bluetooth radio is on, press and hold the Bluetooth button  to 
turn it off.

2. If background music is active, tap the Music Controls icon  in the Status 
Bar, pause music playback, and then try your game again. 
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I beamed (or sent) one of my Zodiac games to my friend and it I beamed (or sent) one of my Zodiac games to my friend and it I beamed (or sent) one of my Zodiac games to my friend and it I beamed (or sent) one of my Zodiac games to my friend and it 
won’t run on his device.won’t run on his device.won’t run on his device.won’t run on his device.

• Most games will only run on Zodiac consoles. 

• Games purchased from the Tapwave store are signed to the serial 
number of the purchaser’s Zodiac. If the game is run on another Zodiac 
console, it may run in demo mode or it may not run at all. 

• Some games require multiple files to run properly and beaming may 
not send all the files, causing the game to crash when launched on the 
receiving Zodiac console. 

I’m using an SD/MMC card reader to load files directly onto an I’m using an SD/MMC card reader to load files directly onto an I’m using an SD/MMC card reader to load files directly onto an I’m using an SD/MMC card reader to load files directly onto an 
expansion card. expansion card. expansion card. expansion card. What folder should I useWhat folder should I useWhat folder should I useWhat folder should I use????

If you’re using an SD/MMC card reader to install files to an expansion card, you 
must place the files in the following folders for your console to recognize 
them. 

Extension Folder File Type

PRC  /PALM/Launcher/ Palm OS application

PDB  /PALM/Launcher/ Palm OS database

JPG /DCIM/ Photo

JPEG  /DCIM/ Photo

MP3   /AUDIO/ Music

WAD, CFL, etc.  /PALM/Programs/(game) Game ID

NOTE:NOTE:NOTE:NOTE: When you install files with a HotSync operation the appropriate file 
types are automatically placed in the correct directories on the expansion card.

How do I connect to my Bluetooth-enabled phone?How do I connect to my Bluetooth-enabled phone?How do I connect to my Bluetooth-enabled phone?How do I connect to my Bluetooth-enabled phone?
The following steps assume you have GPRS service on your phone and that 
you have the User ID and Password for your GPRS service. 
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Here are the steps to connect via GPRS on the Zodiac:

1. Press the Home button .

2. Select the Prefs category .

3. Select Connection. 

4. Tap New to create a new connection. 

5. Enter the following settings:

• Name. Enter GPRS as the name of the connection.

• Connect to. Tap the pick list and select Local Network.

• Via. Tap the pick list and select Bluetooth.

6. Tap the Tap to Find button and discover the phone. 

7. From the pick list in the upper-right corner of the screen, select Network.

8. Tap New to create a new network service.

9. Enter your username and password for your GPRS service, this is carrier 
dependent.

10.From the Connection pick list, select GPRS (the connection you just 
created).

11.Tap Details.

12.On the Details screen, tap Script.

13.Enter the following script:

    Send: ATD*99***<CID>#

    Send: CR

    Wait For: CONNECT

    End:

NOTE:NOTE:NOTE:NOTE: Some of the script settings are carrier-specific. Please verify 
this information with your wireless carrier.

ATD*98***<CID># may be used for some carriers.

Replace <CID> with the CID number your phone uses to connect to the network 
(usually 1 or 2). This can be found in the settings on the phone.
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How do I connect to my Bluetooth-enabled computer?How do I connect to my Bluetooth-enabled computer?How do I connect to my Bluetooth-enabled computer?How do I connect to my Bluetooth-enabled computer?
1. Press the Home button .

2. Select the Prefs category .

3. Select Connection. 

4. Tap New to create a new connection. 

5. Enter the following settings:

• Name. Enter BT PC as the name of the connection.

• Connect to. Tap the pick list and select PC.

• Via. Tap the pick list and select Bluetooth.

6. Tap the Tap to Find button and discover the PC. 

7. When the Discover Results screen appears, select your PC from the list, 
and then tap OK.

NOTE:NOTE:NOTE:NOTE: You must set up Internet Connection Sharing within Windows to 
allow an Internet connection through the PC. 

How do I connect to my Bluetooth-enabled access point?How do I connect to my Bluetooth-enabled access point?How do I connect to my Bluetooth-enabled access point?How do I connect to my Bluetooth-enabled access point?
Follow these steps to create a Bluetooth connection to a wireless LAN access 
point:

1. Press the Home button .

2. Select the Prefs category .

3. Select Connection. 

4. Tap New to create a new connection. 

5. Enter the following settings:

• Name. Enter BT LAN as the name of the connection.

• Connect to. Tap the pick list and select Local Network.

• Via. Tap the pick list and select Bluetooth.



Troubleshooting
I just downloaded and installed a game. I’m now getting an error that I’m missing a file.

Using Your Zodiac Console 186186186186

6. Tap the Tap to Find button and discover the PC. 

7. When the Discover Results screen appears, select the device you want to 
connect to from the list, and then tap OK.

NOTE:NOTE:NOTE:NOTE: You will need a username and password to connect to the access point. 

I just downloaded and installed a game. II just downloaded and installed a game. II just downloaded and installed a game. II just downloaded and installed a game. I’m’m’m’m now getting an  now getting an  now getting an  now getting an 
error that Ierror that Ierror that Ierror that I’m’m’m’m missing a file.  missing a file.  missing a file.  missing a file. 

Some games have their own installers instead of using the standard Palm 
Install Tool. These installers place all the appropriate files (CFL files) onto the 
Zodiac console, either in main memory or on a card. Check the folders in the 
downloaded file for an INSTALLER.EXE file and run it. Most games of this type 
come with a TXT file with further instructions.

Also make sure the file you are trying to install is not a compressed file, such as 
a ZIP or SIT file. If the application is compressed, you must decompress the file 
before installing it. Right click the ZIP file, extract all files, and then run the 
INSTALLER.EXE file.

I’m having trouble establishing a networI’m having trouble establishing a networI’m having trouble establishing a networI’m having trouble establishing a network connection.k connection.k connection.k connection.
If you have problems connecting to a network using TCP/IP, you can display 
information to troubleshoot the problem. You can display expanded Service 
Connection Progress messages. You can also display the Network Log to see 
all communication between your modem and dial-in server during login. This 
information can help your ISP or your System Administrator identify where 
and why the login communication fails.

In addition, check with your system administrator whether a DNS number is 
required. If a number is required but not entered, the connection may fail. If a 
DNS number is required but not entered, logging on to your network may 
appear successful. However, the connection fails if you try to use an 
application or look up information. See page 134 for information on entering 
a DNS number.



Troubleshooting
How do I view progress messages during network login?
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How do I view progress messages during network login?How do I view progress messages during network login?How do I view progress messages during network login?How do I view progress messages during network login?
1. In the Network Preferences screen, tap Connect. See page 139 for more 

information on connecting to your ISP or dial-in service.

2. To see expanded Service Connection Progress messages, move the 
analog controller  Down during login.

How do I view the Network Log?How do I view the Network Log?How do I view the Network Log?How do I view the Network Log?
1. In the Network Preferences screen, tap the Menu icon .

2. From the Options menu, select View Log.

3. Tap the Up and Down arrows of the scroll bar to see the entire Network 
Log.

4. Tap Done.
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22
RegulatorRegulatorRegulatorRegulatory Informationy Informationy Informationy Information

Federal Communication Commission Interference StatementFederal Communication Commission Interference StatementFederal Communication Commission Interference StatementFederal Communication Commission Interference Statement
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to operate this 
equipment.

Important Note: FCImportant Note: FCImportant Note: FCImportant Note: FCC Radiation Exposure StatementC Radiation Exposure StatementC Radiation Exposure StatementC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for an 
uncontrolled environment. End users must follow the specific operating instructions 
for satisfying RF exposure compliance.

This transmitter must not be co-located or operating in conjunction with any other 
antenna or transmitter.



IndexIndexIndexIndex
Numerics
24-hour clock 129

A
accented characters 37
access restrictions 149
accounts 18
Acid Solitaire 66
Action buttons 20
activities 92
adding

categories 46, 76
expansion cards 158

add-on applications 49, 51, 178
Address Book

See also Organizer applications
adding custom fields 90
adding entries to events from 97
adding notes 82
categorizing records for 74
creating records for 71, 86–87
default categories for 75
deleting records from 74
duplicating entries for 88
editing categories for 76
editing entries 88, 89
finding records 77
opening 85
overview 85, 86
setting preferences for 90
sorting records in 80, 90
viewing entries 88

Address Entry Details dialog 89
Address icon 85
Address List view 88, 89
addressing e-mail 88
adjusting

screen orientation 23
volume 23, 54, 143

Agenda view 106
Agenda view icon 106
alarm clock 68

Alarm icon 100
Alarm Preset check box 155
Alarm Vibrate setting 143
alarms

accessing 69
adjusting volume for 69, 143
delaying 101
responding to 154
selecting sounds for 69, 102, 155
setting 100
specifying duration for 102
specifying preferences for 102
specifying repeat intervals for 155
types described 154, 157

alerts 26
See also alarms; reminders

All Day button 95
All view list 24
alphabet 35
alphabetic keyboard 39
alternate writing strokes 131
analog clock 69
analog controller 16, 20

calibrating 125
application buttons 28
applications

See also Organizer applications
adding add-on 49, 178
beaming 162, 169
common tasks for 71
connecting to 140
copying 17, 161
creating categories for 45, 46
default categories for 75
deleting 51, 163
displaying information about 160
documentation for 11
getting information on 48
importing from 41
installing 147
launching from expansion cards 159
locating text in 78, 79
managing 43
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navigating through 29
opening 24, 25, 44

shortcuts for 48, 141
organizing 45
running 16

Applications Launcher. See Home screen
applying fonts 84
appointments 92, 103, 154
archives 74
arranging icons 45
Ascending setting 69
Attention icon 26
Attention Manager 154–157
audible alarms 157
Auto-off after setting 15, 130
Autotext features 38

B
back panel 21
Background Playback preference 58
Background preference 47
backgrounds 47
backing up data 158
backing up files 16
backing up shortcuts 147
Backspace stroke 35
battery 14–15

extending life of 15, 56, 130
Beam command 162
Beam Receive setting 15, 130, 169
Beam Status dialog 168, 169
beaming

applications 169
from expansion cards 162
individual records 168
overview 167
tips for 168
turning off 130

blinking alarm indicator 157
blinking cursor 34
Bluetooth button 19, 124
Bluetooth radio

playing multi-player games from 67
sending information with 167, 170

setting preferences 124
turning on/off 15, 124

boilerplates. See shortcuts
Bonus Software applications 17, 49
Box control 28
brightness control 23, 26, 131
buddy lists 124
built-in applications 51

See also Organizer applications
business cards 168
buttons

application 28
back panel 21
Calculator 121
front panel 19
not responding 179

C
cable 13, 130, 173, 177
calculations

displaying 122
performing 120, 121
storing in memory 121

Calculator 120–122
buttons described 121

Calculator icon 120
calendar 103, 127, 128

See also Date Book
calibrating touch-screen 16, 125
Calibration Preferences screen 125
call waiting 133
calling cards 134
capitalization 71
CardInfo application 164
categories

assigning records to 74, 75
assigning to addresses 89
assigning To Do items to 119
attaching notes to 110
changing 76
creating 46, 76
default application 75
deleting 47, 77
displaying 75, 90
organizing applications in 45
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renaming 46, 76
selecting 43
viewing most recent 90

Category command 45, 46, 47
Category View

opening 45
removing categories from 47, 77
selecting categories in 24, 44

Change Repeat dialog box 98
Change Security dialog 81
changes, undoing 72
changing

addresses 88
categories 76
date/time formats 68
passwords 151, 152
records 72
scheduled events 96, 97, 99
screen orientation 23
shortcuts 142
To Do priorities 117

character sets 27, 32
characters

deleting 35
drawing accented 37
shortcuts for entering 38
writing special 35, 36–37, 138

charging battery 14–15
chime tones 143
clock 127, 128, 129
Clock application 68–70
Clock icon 68
Color Theme preference 47, 58, 63, 131
command toolbar 30
communications 125
company names 87, 90, 139
company phone lists 176
Compress Day View option 108
conduit (defined) 147
configurations 125, 140, 172

multiple handsets 176
conflicting events 107
Connection Preferences screen 125–127
connection protocol 134

connection software 18
connections

automatic 124
external keyboards 41
requirements for 12
selecting configurations for 140
selecting network 133
setting device type for 126
setting ISP 139
setting preferences 125–127
setting up HotSync 13
setting up remote 132, 136
terminating 139
testing 140
troubleshooting 186–187

conserving battery power 15, 56, 130
console screen. See touch-screen
contact information 87, 139
contacts. See Address Book
continuous events

changing 99
defined 93
scheduling 92, 98, 99

controller. See analog controller
Copy command 73, 161
Copy dialog box 162
copying

applications 17, 161
photos 65
text 73

correcting interference 188
country information 129
CPUs 21, 40, 125, 173

system requirements for 12
cradle 13, 130, 173, 177
creating

business cards 168
categories 46, 76
login scripts 136
memos 111
records 71
shortcuts 142
song lists 54
untimed events 97
user profiles 176–177
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current dates 69, 128
customizing

console 123
Home screen 45
HotSync Manager 147–148

Cut command 72

D
data

backing up 158
editing 38
entering 28, 32, 41

shortcuts for 38, 142
importing 41
overwriting 147
paging through 29
preserving 16, 174
restoring 180
selecting all 73
synchronizing 40, 144, 153
transferring 167

databases 41, 147, 162, 163
Date & Time Preferences screen 127–129
Date Book

See also Organizer applications
adding addresses to events from 97
changing views 103, 107
creating records for 71
displaying conflicting events 107
finding records in 77, 79
opening 92
overview 92
purging records from 74
removing repeating events 73
rescheduling events for 97, 99
scheduling events 93–97, 98

tips for 99
setting alarms for 100, 102, 155
setting preferences for 108

Date Book icon 92
date formats 68, 130
dates

displaying current 69
displaying photo 61
selecting event 96, 99, 100
setting 68, 117, 128

shortcuts for entering 38
sorting on 118

day events 93
Day view 94

setting display options for 107, 108
Daylight Saving option 129
defaults 75, 129, 181
Delete command 73, 163
Delete dialog box 51, 164
deleting

applications 51, 163
categories 47, 77
characters 35
events 156
notes 83
Palm Desktop software 52
passwords 151, 152, 153
pictures 63
records 73, 74
repeating events 73
shortcuts 142
songs 56
text 72

desktop organizers 18, 40, 174
Desktop Overwrites Handheld option 174
desktop setup 14
desktop software. See Palm Desktop
Details dialog 127, 134
dialing mode 126
dialing preferences 126, 133
dialog boxes 31
dial-up connections 125, 126, 127, 139
digitizer 16
Discovery Results screen 170
Display Options command 107
Display Options dialog 108
displaying

addresses 88
applications 24
appointments 103
calculations 122
categories 75, 90
conflicting events 107
current date 69
Home screen 26
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international keyboard 40
memos 112
menus 45
onscreen keyboard 39
photos 60
priorities 115, 119
private records 81, 82, 89
song lists 54
tips 31
videos 15

DNS numbers 135, 136
documentation 11
Domain Naming System (DNS) 135
downloading records 86
drivers 140
due dates 117, 119
Duplicate Record command 88

E
Edit Categories dialog 46, 47
Edit Categories option 76
edit line 72
Edit menu 72
edit mode 72
editing 72, 88, 89, 142

See also changing
editing commands 38
e-mail 88
Enable infrared communication 171
End Time setting 109
entering data 28, 32, 41

shortcuts for 38
entering passwords 81, 139
escape characters 138
events

adding addresses to 97
changing preferences for 108
creating untimed 97
deleting 156
displaying conflicting 107
displaying time bars for 108
entering descriptions for 94, 97

rescheduling 96, 97, 99
scheduling 93–97, 98

tips for 99
setting alarms for 100, 102
setting duration for 93, 94, 95
types described 92

Expand/Collapse icon 26
expansion cards

accessing applications on 159
adding 158
beaming from 162
copying from 161
copying pictures to 65
displaying information for 160, 164
reformatting 165
removing songs from 56
renaming 165
uploading pictures to 62
uploading songs to 55
viewing songs on 54

expansion slots 21
extending battery life 15, 56, 130
extensions-off reset 180
external keyboards 41

F
FAQs 178
file formats 41
files

backing up 16
caution for copying 17
importing from 41
sharing 158
synchronizing 147

Find dialog box 78
Find icon 26
finding records 77–79
Font command 84
fonts 84
forgetting passwords 153
Format Card command 165
formats 41, 68

specifying default 129
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formatting expansion cards 165
freeing memory 51
front panel 19
Full-Screen mode 60
Function button 20

G
games

adjusting volume for 143
installing third-party 49
playing 66

General Preferences screen 130–131
gestures 38
Go to Date dialog box 96
Graffiti 2 area. See Input Area
Graffiti 2 demo 32
Graffiti 2 Help command 73
Graffiti 2 Help file 37
Graffiti 2 Preferences screen 131
Graffiti 2 ShortCuts 38

backing up 147
Graffiti handwriting software 32–39

editing commands for 38
tips for 35

grouping applications 45

H
handwriting software 32–39

editing commands for 38
tips for 35

hard resets 152, 180
Headphone Bass preference 58
Headphone Bass setting 143
headphones 15, 22
help 17, 31
Hide Records setting 151
hiding records 81, 150
High Score Service conduits 147
Hold command 57
Hold state 56
Home button 20, 26, 159

Home category 159
Home screen

customizing 45
displaying menus in 45
managing applications from 43–45
opening 26
overview 24
setting preferences for 47

horizontal orientation (screen) 23, 26
HotSync button 145
HotSync cables 13, 130
HotSync command 147
HotSync connector 21
HotSync Manager

configuring for infrared devices 172
customizing 147–148
running 145, 146

HotSync operations
creating user profiles for 176–177
disabling chime tones for 143
initializing 144
IR ports and 171
multiple devices and 175
performing 40, 144–146, 171, 173
setting defaults for 148
setting options for 146–147
setting up connections for 13
upgrades and 174

HotSync technology 12, 144

I
icons 24, 45

displaying alphabetical list of 48
idle 135
image files 59, 61
importing data 41
Info command 48, 160, 178
Info dialog box 160
Info screen 48
infrared devices 172
Input Area 26, 27, 131

entering data in 33
Input Area Position setting 131
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insistent alarms 154, 156
Install conduits 147
Install Tool dialog 50
installation

applications 49, 147, 178
caution for 188
Palm Desktop 17, 174
system requirements for 12

installer 17
interference 188
international keyboard 40
Internet

connecting to 125, 134, 139
creating login scripts for 136
creating service templates for 132

IP addresses 135, 136
IR port

beaming from 167, 168, 169
location of 21
performing HotSync operations with 171–173

ISPs 125, 132, 139
creating login scripts for 136

J
joystick. See analog controller

K
keyboard

connecting to external 41
entering data from 27, 40
opening onscreen 39, 73

Keyboard command 73
keyboard shortcuts 30

L
landscape orientation 23, 26
laptops 171, 173
launching applications 160
LED display 14
lines, selecting entire 72
locating records 77–79
Lock & Turn Off option 152
lock icons 162, 163, 169

locking console 151, 152
Login Script dialog 136
login scripts 136–138
Look Up option 77
Lost Password setting 153
lowercase letters 33

M
macros. See shortcuts
maintenance 177
Mask records setting 81, 150
mathematical calculator 120
Media category icon 59
meetings 92
Memo List 111, 112
Memo Pad 110–112

See also Organizer applications
categorizing records for 74
creating records for 71
default categories for 75
deleting records from 74
editing categories for 76
finding records in 77, 79
manually arranging records in 80
reviewing entries in 112
setting preferences for 112
sorting records in 80

Memo Pad icon 110
memory 51, 74, 111
memory cards. See expansion cards
memos 110, 111, 112

sorting 112
menu bar 26
Menu command stroke 38
Menu icon 26
menus

arranging icons on 24, 45
choosing commands 29, 30
displaying 26, 45

messages 110, 154
Microsoft Outlook 18, 144
migration 174–175
mobile phones 125, 167
modems 125, 126, 127
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Month view 105
setting display options for 107, 108

Month view icon 105
moving

applications 45
icons 45

MP3 files. See Music application
MP3 player 53
multi-player games 67
multi-stroke characters 33
music, listening to 15
Music application

beaming from 167
creating song lists for 54
removing songs from 56
running 53–56
setting preferences for 57
uploading songs to 55

music control 26
Music Control dialog box 26
Music Controls icon 26
Music icon 53
Mute icon 23, 26
My Stuff category 68

N
naming

categories 46, 76
console 175
user profiles 176

navigating 25, 29
navigational controls 29
Navigator. See analog controller
Network Log 187
Network Preferences screen 132–139
networks

connecting to 126, 133, 134
setting login scripts for 136–138
setting preferences for 132
troubleshooting connections for 187

new lines 111
news readers 139
non-ASCII characters 138

note icon 83
notes 82, 83, 110

See also Memo Pad
notifications 154
numbers

entering 32, 33, 39
formatting 130
shortcuts for 38
tips for writing 35

numeric keyboard 39

O
One button Quick Launch from Home Screen 

preference 48
online help 17
onscreen keyboard 27, 39–40

opening 73
Open to All Applications preference 48
opening

Address Book 85
applications 24, 25, 44

shortcuts for 48, 141
Calculator 120
Category View 45
Clock application 68
Date Book 92
Home screen 26, 159
Info screen 48
Memo Pad 110
onscreen keyboard 39, 73
Photos application 59
Stroke Lookup screen 73
To Do List 113

options 47, 108, 146, 149
Organizer applications 40, 71, 82

changing font styles for 84
organizing applications 45
orientation (screen) 23
Orientation icon 23, 26
outdated records 74
Outlook 18, 144
overlapping events 107
overwriting data 147
Owner Preferences screen 139
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P
paging through data 29
Palm Desktop

compatibility with 16
importing from 41
installing 12, 17, 174
removing 52
synchronizing with 144, 147
upgrades and 174

Palm OS devices 167
Palm Powered devices 167
passkeys 124
passwords

entering 81, 139
recovering 153
saving 133
setting 151, 152
upgrades and 174

Paste command 73
PCs 21, 40, 125, 173

system requirements for 12
pen. See stylus
personal information 87, 139
phone book. See Address Book
phone drivers 140
phone lists 176
Phone Lookup command 79
Phone Lookup option 78, 97, 111, 114
phone numbers. See telephone numbers
Phone Preferences screen 140
Photos

setting preferences for 63
Photos application 59–65

ordering pictures in 60
uploading pictures to 62

Photos icon 59
Pick list control 28
picture lists 60, 63
pictures

copying 65
deleting 63
managing 59
rotating 61
uploading to console 62
viewing location of 61

PIM. See Organizer applications
Play/Pause button 54
playback 54
playing games 66
portrait orientation 23
ports 21
Power button 19
Power Controls icon 23, 26
preferences 47, 57, 123
Preferences command 47
Prefs category 123
preserving data 16, 174
printing 16
prioritizing To Do items 115, 117
Private check box 81
private records 81, 82, 117, 150

caution for deleting passwords and 153
profiles 17, 176, 177

naming 176
progress messages 187
punctuation marks 36
Purge command 74
purging records 74, 116

Q
Quick Launch 48, 141
Quick Launch preference 141
quick strokes 30

R
radial menu 24, 45
radiation exposure 188
radio. See Bluetooth radio
rearranging icons 45
reboots 152, 179, 180
receiving information 15
Recent Calculations command 122
recharging battery 14
Record Completion Date option 119
records

assigning passwords to 151
attaching notes 82
beaming 168
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categorizing 74–75
caution for deleting passwords and 153
creating 71
defined 71
deleting 73
displaying private 81, 82, 89
downloading 86
duplicating 88
editing 72
finding 77–79
hiding 81, 150
manually arranging 80
marking as private 81, 117
purging 74, 116
receiving 170
saving 74
sorting 79–80

recovering passwords 153
recurring events. See repeating events
reminders

creating 113
responding to 154, 156
setting alarms for 100, 102
viewing 156

Reminders dialog box 154, 156
closing temporarily 157

remote computers 125
remote connections 132, 136, 186
removing. See deleting
Rename Card command 165
Rename Custom Fields command 90
Rename Custom Fields dialog 91
renaming

categories 46, 76
expansion cards 165

Repeat button 54
Repeat check box 98
repeat intervals 99, 155
Repeating Event dialog 99
repeating events

changing 99
defined 93
displaying 108
removing 73
scheduling 92, 98, 99

replacing stylus 25
replaying songs 53, 54
rescheduling events 96, 97, 99
Reset button 21, 179
resets 152, 179, 180
responding to alarms 154
responding to reminders 156
restoring data 180
restricting access 149
Rotate icon. See Orientation icon
rotating photos 61

S
Save Archive check box 74
Save Archive Copy on PC check box 74
saving

passwords 133
records 74

schedules 92, 107
scheduling events 93–97, 98

tips for 99
screen

adjusting brightness 23, 131
adjusting orientation of 23
calibrating 16, 125
described 20
enlarging 26
navigating through 25
replacing backgrounds for 47
restrictions for 25

scroll bar slider 29
scrolling 29, 54, 77
Search icon. See Find icon
searches, halting 78
searching 26, 77, 79
security 81, 133, 139, 174
Security application 149–153
Security command 81, 82
security options 149
Select All command 73
Select Business Card command 168
Send command 162
sending information 167, 170

See also beaming
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Service Connection Progress messages 139, 187
service templates 132, 134, 136
Set Time & Date command 68
Set Time dialog 94, 95, 96
setting

alarms 100, 102
passwords 151, 152
preferences 47, 123

setup instructions 16
sharing files 158
Shift command 36, 37
Shift indicator arrow 36
Shift stroke 36, 37
ShortCut Preferences screen 141
ShortCut symbol 39
shortcuts 30, 31, 38

backing up 147
creating 142

Show Categories option 119
Show Completed Items option 116, 119
Show Daily Repeating Evts option 108
Show Due Dates option 117, 119
Show Only Due Items option 119
Show Priorities option 115, 119
Show Records option 82
Show Time Bars option 108
Show Timed Events option 108
Show Untimed Events option 108
Shuffle button 54, 60
silent alarms 100
Slide Duration pick list 63
slide shows 60, 63
slider arrows 29
SMS software 167
Snooze button 101, 155, 157
soft resets 179
song list

creating 54
removing songs from 56
scrolling through 54

songs
assigning to alarms 69
deleting 56

replaying 53, 54
selecting 54
uploading to console 55

sorting
addresses 90
memos 112
records 79–80
To Do List items 118

Sound Preferences screen 143
sound tracks 53
sounds

disabling 143
interrupting 154
setting for alarms 69, 102, 155

speakers 15, 20, 23, 54
special characters 36–37, 138
spreadsheets 41
start dates (events) 99, 100
Start Time setting 109
start times (events) 95, 108
starting Zodiac console 16
static electricity 177
Status Bar 26, 131
Stay on in Cradle setting 130
Stop Music on Exit preference 58
stopwatch 68, 69, 70
storage 158
storing songs 54
Stroke Lookup screen 32, 73
Stunt Car Extreme 66
stylus 21, 22, 25

replacing 25
stylus channel 21
subtle alarms 157
symbols 32, 33, 36
synchronizing data 40, 144, 153

See also HotSync operations
System Color Theme 131
System conduits 147
System Lockout dialog 152, 153
system requirements 12
system reset 180
system sounds 143
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T
tapping 25
Tapwave web site 147
tasks. See To Do List
TCP/IP settings 134, 139
TCP/IP software 132
telephone numbers

See also Address Book
adding to phone lists 176
dialing 133
entering 78, 139
selecting 88
temporarily storing 110

telephones
selecting model 127
setting modem connections for 126–127
setting network connections for 133

templates. See shortcuts
testing connections 140
text

editing 38
entering 32, 33, 39, 114

creating shortcuts for 142
locating 78, 79
replacing 79
selecting 72, 73
temporarily storing 110

third-party applications 49
thumbnails 60
time 68, 94, 128

See also clock
time bars 108
time formats 68, 130
time zones 128
timed events

changing to untimed 97
defined 93
displaying 108
scheduling 92, 94, 96

timeouts 135
timer 68, 69, 70
timestamps 39, 61
Tips icon 31

To Do Item Details dialog 117
To Do List

See also Organizer applications
categorizing records for 74
checking completed items 106, 116
creating items for 71, 114, 115
default categories for 75
displaying items 119
editing categories for 76
finding records in 77, 79
hiding items in 117
opening 113
overview 113
purging records from 74, 116
setting preferences 118–119
setting priorities 115, 117
sorting items 79, 118

To Do List icon 113
To Do Preferences dialog 119
toolbar 30

See also Status Bar
touch-screen

adjusting brightness 23, 131
adjusting orientation of 23
calibrating 16, 125
described 20
enlarging 26
navigating through 25
replacing backgrounds for 47
restrictions for 25

transferring data 167
See also beaming

travel setup 14
Trigger buttons 19
troubleshooting 178
turning off console 15, 19, 130
turning on Zodiac console 19

U
ultra-light setup 14
unauthorized users 149
Undo command 72
Unfiled category 74, 170
uninstalling desktop software 52
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untimed events
defined 93
displaying 108
scheduling 92, 96
setting silent alarms for 100

upgrades 13, 174–175
uploading

pictures 62
songs 55

uppercase letters 33
user accounts 18
user names 17, 133, 139
user profiles

creating 176–177
multiple consoles and 17
selecting 177

Users command 176
Utilities category 164

V
Version button 161
vertical orientation (screen) 23
vibrating alarms 143
videos 15
viewing

addresses 88
applications 24
appointments 103
calculations 122
categories 75
conflicting events 107
current date 69
Home screen 26
international keyboard 40
memos 112
menus 45
onscreen keyboard 39
photos 60
priorities 115, 119
private records 81, 82, 89
song lists 54
tips 31
videos 15

visual alarms 157

volume
adjusting 23, 54, 143
caution for 15, 22
setting alarm 69, 143

volume control 26

W
warm resets 180
Web browsers 139
web site (Tapwave) 147
Week view 103–104
Week view icon 103
weekly events 92
Welcome application 32
Windows system requirements 12
writing area. See Input Area
writing strokes

demo for 32
enabling alternate 131
guidelines for 33
special characters and 36
tips for 35

Z
Zodiac console

adding expansion cards for 158
components described 19–21
configuring 125, 176
connecting to 132
customizing 123
deleting applications from 163
installing applications for 147
locking/unlocking 151, 152, 153
maintaining 177
migrating to 174–175
overview 12
providing contact information for 87
resetting 152, 179, 180
running multiple 175
selecting user profiles for 177
setting idle timeout for 135
setting up 14, 16
starting 16
supported file formats for 41
turning off 15, 19, 130
upgrading 13, 174–175
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